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Welcome
This user guide will introduce you to Store Visualizer 18. It provides a step-by-step approach to the most commonly 
used features and will allow you to quickly familiarize yourself with the software. 

We hope you enjoy using Store Visualizer !
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You may access help and technical support resources at any time from within Store Visualizer. 
Press the “Help” icon located on the left hand side of the bottom toolbar, as shown on the image below. 

Product manual
Selecting the “Open product manual” option will open the Store Visualizer user guide, which you are currently reading. You may also 
press F1 at any time to access this manual.

Store Visualizer quickstart guide
An online quickstart guide is available as a quick and easy step-by-step introduction into Store Visualizer. You can open the quickstart 
guide by selecting the second option in the “Help” menu or by clicking the following link: 
Quickstart guide

Technical support

Customized virtual 3D stores
Our 3D design studio offers virtual 3D store modeling services according to the needs of your projects, as well as the capture of 
photographic spherical stores acquired at the location of your choice. For more information, click on the following link:

Services > Virtual 3D stores

http://www.vtales.com/www/quickstart/sv18/EN/quickstart_sv01.html
http://www.vtales.com/www/quickstart/sv18/EN/quickstart_sv4-01.html
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A.  Navigation
B.  Object control
C.  Environment
D.  Physics

Toolbar panel

Chapter 1 : Interface

The Store Visualizer user interface is divided into two distinct parts: a horizontal toolbar and information panel at the bottom and a vertical sidebar 
on the right hand side. The panel accesses navigation and interaction toolbars, while the sidebar contains control, scene and project related features. 
The 3D visualization is displayed on the large gray area, the render area.

Sidebar

The sidebar contains three 
feature categories which 
can be accessed by clicking 
on the respective tab:
  - System sidebar tab
  - Tools sidebar tab
  - Scene sidebar tab

Figure 1-02

Figure 1-01

A B C D

Right click anywhere on the gray empty area (the 3D render area). 
The main contextual menu will appear.

Contextual menu
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This toolbar controls how the user navigates and moves through the environment or 3D world (see chapter 2 and 3).

This toolbar contains lighting and environment related functions and parameters (see chapter 13).

The object toolbar allows the placement and interactive modification of objects within a 3D environment (see chapter 6).

A. Navigation

B. Object placement

C. Environment

1.1  The toolbar and information panel

The “tool” panel, located at the bottom of the screen, is divided into four separate tool bars. They can be enabled by clicking on their respective toolbar 
icon on the left hand side of the tool panel (Fig. 1-01).

The entire interface (Toolbar and sidebar) can be made invisible simultaneously by clicking on one of the “Hide interface” icons located to 
the left and right extremities of the toolbar. To make the interface reappear, move the mouse pointer into the lower left or right corner of the 
screen and click the left mouse button. You may also press the “i” key to toggle interface visibility. 

The Physics toolbar is used to control and configure the physical simulation (see chapter 16).

D. Physics
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Individual rollouts are detachable and dockable, so to make commonly used features easier for access. Click on the “small arrow” icon on the right 
side of a rollout header to detach it (Fig. 1-03). Most sidebar rollouts are resizable in their detached state, allowing a more efficient usage. They can 
be docked again to the sidebar by simply closing them (Fig. 1-04).

1.2  The sidebar

Figure 1-03

The sidebar is visible by default when running Store Visualizer for the first time. Press the “b” key to toggle the sidebar visibility. This will allow for a 
larger view onto the 3D area.

The sidebar is the vertical area located on the right hand side of the screen. It is separated into three sections giving access to distinct feature 
categories: System, tools and scene (Fig. 1-02). A section can be enabled by clicking on its respective sidebar tab. 

Each section contains a number of rollouts which can be open or closed. Click on a rollout header to open it and a second time to close it again.

Figure 1-04
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The time to load a project will vary according to its size and complexity. The larger the project, the longer the loading will take.

1.4  Opening an existing project

Using the contextual menu:

Or, using the system sidebar:

• Right click on the Store Visualizer render area to open the main contextual menu.

• Select: File > Open.

• The “Open file” dialog window will appear.

• In the system sidebar, open the “File” panel, and select: Project > Open.

• The “Open file” dialog window will appear. Browse through your computers file hierarchy to find the project you would like to open.

• In order to enter a folder, just double click on it.

• Double click on a project file or select it and click on Open.

• The project will load, and a loading bar will show the progress of the operation.

1.3  Creating a new project

Store Visualizer supports two distinct project types : spherical photographic environments and virtual 3D environments. Each project type offers 
a distinct set of features when creating it and interacting with it. Please refer to chapter 2 and chapter 3 for a detailed explanation of spherical and 
virtual 3D environments respectively.
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1.6  Saving the project

Using the contextual menu:

Or, using the system sidebar:

A small disk icon appears on the bottom information panel if the current project was modified. Clicking it will save all changes to the current 
project file, and is identical to the Save operation outlined above.

• Right click on the Store Visualizer render area to open the main contextual menu.

• Select: File > Save or File > Save as.

• Save will write any modifications to the currently opened project file.

• Save as lets you save the current project under a new file name. The previous project file will not be modified.

• In the system sidebar, open the File panel, and select: Project > Save or Project > Save as.

• Save will write any modifications to the currently opened project file.

• Save as lets you save the current project under a new file name. The previous project file will not be modified.

1.5  Closing a project

Using the contextual menu:

Or, using the system sidebar:

When closing a project with unsaved changes, Store Visualizer will ask whether the modified project should be saved, the modifications 
discarded, or if you prefer to cancel the operation.

• Right click on the Store Visualizer render area, and select: File > Close.

• In the system sidebar, open the “File” panel, and select: Project > Close.
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1.7  Quitting Store Visualizer

Using the contextual menu:

Or, using the system sidebar:

When attempting to quit with unsaved changes, Store Visualizer will ask whether the modified project should be saved, or the modifications 
discarded.

• Right click on the Store Visualizer render area to open the main “contextual menu”.

• Select: File > Quit.

• In the system sidebar, open the File panel, and select: Project > Quit.
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A project based on a spherical photographic environment allows you to place your 3D models into photographically acquired shelving from an actual 
existing store. Your packaging models and products can be seamlessly integrated with existing photographic products already on shelf.

Store Visualizer comes with 5 sample spherical environments. Additional environments can be created according to your specifications, in a location 
of your choice. Please contact your sales representative for more information about this service.

2.1  Introduction

Chapter 2 : Spherical photographic environments
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A new project can be created by one of two different ways:

Or alternatively:

• Right click anywhere on the gray empty area (the 3D render area). The main 
contextual menu will appear.

•  Select File > New.

•  The “Create a new project” dialog window will appear (Fig. 2-03).

•  In the System sidebar tab, open the “File” panel and select Project > New. 

•  The “Create a new project” dialog window will appear (Fig. 2-03).

Figure 2-01

Figure 2-02

2.2  Creating a new spherical project from a template
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Figure 2-03

• Click on the “spherical” folder. A list of available spherical templates will 
appear. 

• Select a template from the list and press OK to open it.

• An empty project will be created from the template. Modifying this new project 
will not alter the template it was created from.
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o  Moving:
  Click and hold the left mouse button or press the arrow up key to move FORWARDS
  Click and hold the left mouse button or press the arrow down key to move BACKWARDS

o  Turning and looking around:
  Move your mouse upwards in order to look up (see note below)
  Move your mouse downwards in order to look down (see note below)
  Move your mouse to the left in order to turn to the left
  Move your mouse to the right in order to turn to the right

Figure 2-04

You can modify the speed (chapter 2.4) and sensitivity of your movements (chapter 4). You may also flip the up and downwards directions 
of your mouse (Select: File > Project > Preferences > System settings > Interactivity > Navigation settings > Invert freelook mode).

• Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
• The navigation toolbar appears (Fig. 2-04), and is now active.

2.3  Navigating in a spherical photographic environment

• Click on either the “Free look” icon, the Middle mouse button (often the scrollwheel !), or the Spacebar to enable freelook mode. 
The mouse cursor and the toolbar will disappear, and the freelook mode is activated.

• By using your mouse or keyboard, you may now navigate within the photographic environment:

o  Exiting the “free look” mode:
  Click on the middle mouse button (or the spacebar) a second time, and the mouse pointer will reappear.
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2.4  Navigation speed

You may change the speed of your movements in the spherical environment using the speed selector button: 

• The speed selector is located on the right hand side of the navigation toolbar.

• Click on the “Select navigation speed” to open the “speed preset list“ (Fig. 2-05).

• Select an appropriate speed level.

Figure 2-05

By default, the speed list contains 5 generic presets.
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A virtual 3D environment gives you complete control over the design and the layout of your 3D virtual retail space. Using the store and shelf editing 
features of Store Visualizer, you can easily add shelving, create aisles, fill them with products and customize the look of your store in real time. 

A project based on a virtual 3D environment allows full freedom of movement and interaction of both camera and 3D models within the simulated area.

3.1  Introduction

Chapter 3 : Virtual 3D environments
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A new project can be created by one of two different ways:

Or alternatively:

• Right click anywhere on the gray empty area (the 3D render area). The main 
contextual menu will appear.

•  Select File > New.

•  The “New project” dialog window will appear (Fig. 3-03).

•  In the System sidebar tab, open the “File” panel and select Project > New. 

•  The “New project” dialog window will appear (Fig. 3-03).

Figure 3-01

Figure 3-02

3.2  Creating a new virtual 3D project from a template
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Figure 3-03

The dimensions and a brief explanation of the virtual store are 
displayed beside a representative image. 

• Click on the Virtual 3D folder. A list of available virtual templates will appear.

• An empty project will be created from the template. Modifying this new project 
will not alter the template it was created from.

3.3  Add a custom folder or install new templates

• 	Right-click in the “New project” window. A contextual menu will appear (Fig. 3-04).

• 	Add/Delete folder: Enables you to manage your custom projects in the list of templates.

• 	 Install package: Enables you to install new template from a zip file. Once installation is complete, the new templates will appear in the list.

Figure 3-04

• Select a template from the list and press OK to open it.
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o  Moving:
  Click and hold the left mouse button or press the arrow up key to move FORWARDS
  Click and hold the right mouse button or press the arrow down key to move BACKWARDS
  Press the right arrow key to move sideways to the RIGHT
  Press the left arrow key to move sideways to the LEFT

o  Turning and looking around:
  Move your mouse upwards in order to look up (see note below)
  Move your mouse downwards in order to look down (see note below)
  Move your mouse to the left in order to turn to the left 
  Move your mouse to the right in order to turn to the right

o  Exiting the free look mode:
  Click on the Middle mouse button (or the Spacebar) a second time, and the
mouse pointer will reappear.

• Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
• The navigation toolbar appears, and is now active.

Several different ways to navigate through a realtime 3D environment exist:

3.4.1  The “FREE LOOK” mode

You can modify the speed (chapter 3.5) and sensitivity of your movements (chapter 24.1). You may also flip the up 
and downwards directions of your mouse (Select: File > Project > Preferences > System settings > Interactivity > 
Navigation settings > Invert vertical mouse).

• Click on either the “Free look” icon, the Middle mouse button (often the scrollwheel !), or the Spacebar to enable free look mode. 
The mouse cursor and the toolbar will disappear, and the free look mode is activated.

• By using the mouse or keyboard, you can freely navigate through the 3D environment:

3.4  Navigating through a full 3D environment
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3.4.3  Orbiting around a target

You may move in circles around a certain point or object using the “Target orbit mode” :

You may use the orbit mode combined with the free look mode. This will allow you to control the distance to the orbit location using the left 
and right mouse buttons (see chapter 3.4.1 for more information about the freelook mode).

• Click on the “Orbit” button. Store Visualizer will query you for an orbit center position.

• Point the cursor onto the object or location you would like to orbit around, and left click your mouse to confirm.

• To circle around the selected location, click and hold the left mouse button while moving the mouse. The camera will follow your 
mouse movements while always keeping focused on the orbit location.

• To exit the orbit mode, just click the orbit icon again.

3.4.2  The “WALKTHROUGH” mode

The walkthrough mode is more limited in movement freedom than the freelook mode, but keeps the mouse cursor visible instead. Please 
refer to chapter 3.4.1 for more information.

o  Moving:
  Click and hold the left mouse button in order to move FORWARDS.
  While moving, point the mouse cursor into the direction you would like to walk.

Walkthrough mode is disabled by default. You can enable it in the Preferences: System > Interactivity 
> Enable walkthrough.

Without using the free look mode, you may still navigate through your project using the “Walkthrough” mode. The mouse pointer will stay visible 
and allow normal access to the application in this mode.



30										                                  	            Store Visualizer 18

3.4.4  Set camera height preset

The current height of the camera (as measured from the ground floor) is shown on the navigation toolbar. A selection of standard height presets is 
available by clicking on the “Height” selector.

• Click on the “Height” selector button located on the navigation toolbar. A list of height presets will appear

• Select a height entry. The camera will automatically adjust to the new view height.

While navigating in freelook mode, you can interactively adjust the camera height by using the Page Up / Page Down keys:
• Press Page Up to increase the camera height (moving up).

• Press Page Down to lower the camera height (moving down).

3.4.5  Toggle layout view

The “layout view” mode will show your store from a birds eye perspective while temporarily removing the ceiling. This mode offers a general view of 
the store floor plan and is well suited for editing the larger scale layout of your project. You will find more information about the layout view mode in 
chapter 9.8.

• Clicking on the “Toggle layout view” icon toggles the mode on and off.

• Click on the “Lock height when moving” entry in the height preset list to toggle height locking on and off. 
• When unlocked, the camera will be floating and gravity-less. When locked, a human observer with a fixed view height will be simulated.

By default Store Visualizer simulates a walking person and the selected view height stays constant while you navigate through the environment. 
Certain situations may require more freedom of movement, such as store construction. For these cases, the height can be unlocked.

You can also manually enter a specific height using the Manual camera entry function (see chapter 3.4.7).
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3.4.6  Align camera to nearest axis

If you have lost orientation during navigation, clicking on the “align camera to nearest axis” feature will place your view at a standard orientation.

• Open the “More actions” menu located on the right hand side of the navigation toolbar.

• Select “Align camera to nearest axis”. 

• The camera view direction will automatically align itself onto the nearest X, Y or Z axis.

You can place the camera in a specific position by manually entering the X, Y, Z coordinates.

• Open the “More actions” menu located on the right hand side of the navigation toolbar.

• Select “Manual camera entry”. 

• The camera view is automatically positioned on the X, Y or Z axis manually entered.

X

Y

Z

Axes o  Camera metrics:
  Position: Manual entry of the current camera position on the X, Y and Z axes (project scale).
  Rotation: Manual entry of the current camera rotation around the X, Y and Z axes.

o  Camera view locking:
�� Clicking the view lock icons will prevent the camera view from changing on the respective 
axes. Clicking the icons again will release the lock. 

This function only affects the camera when it is moving, when collision is activated (by default). The camera cannot cross through the walls and floor 
of 3D environments. Camera collision is enable even where physical simulation is not! 

• Open the “More actions” menu located on the right hand side of the navigation toolbar.

• Select “Enable collision detection”.

3.4.7  Manual camera entry

3.4.8  Enable camera collision
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3.5  Navigation speed

You may change the speed of your movements through the 3D environment using the speed selector button: 

• The speed selector is located on the right hand side of the navigation toolbar.

• Click on the Select navigation speed to open the “speed preset list“ (Fig. 3-05).

• Select an appropriate speed level.

Figure 3-05

The speed selector contains five presets, from very slow to very fast. The normal preset represents the 
average walking speed of an adult.
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4.3  Next and previous camera

4.1  Create new camera

New camera is the default name.

• Click on the “left arrow” to switch to the previous camera.
• Click on the “right arrow” to switch to the next camera.

• Click on the “Add a new camera” icon.
• The “Camera settings” dialog will open (Fig. 4-02). Enter the name of the new camera.

4.2  Camera list

The list of currently stored camera views can be easily accessed from the toolbar by using the camera selector. When 
choosing one of the available cameras, the 3D view will automatically switch to the location and view direction stored 
with the camera entry that was selected.

Chapter 4 : Using cameras

Figure 4-01

• Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
• The navigation toolbar appears (Fig. 4-01), and is now active.

Select “Edit camera settings” at the bottom of the list to open the camera properties dialog.

The Ctrl-Left and Ctrl-Right keyboard shortcuts can be used to easily cycle through all available camera presets. 
These shortcuts are also available in freelook mode.



34										                                  	            Store Visualizer 18

4.4  Edit camera settings

Figure 4-02

o  Add new entry: Create a new camera preset at the current location.

o  Edit camera position allows the modification of an existing preset. Click on the “Edit camera 
position” button to enable modification mode. Use the usual navigation functions to move your 
camera to the new position. Click the “Edit camera position” button again to store the new 
position and view direction for the selected preset.

o  Remove entry: Remove the selected camera preset from the list.

o  Move entry up/down: Use these buttons to reorder your camera presets within the list.

The “Camera settings” dialog can be opened in two ways:

• Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
• Open the camera presets and select “Edit camera settings” at the bottom of the list (see chapter 4.2).

• Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
• Open “More actions” on the right hand side of the toolbar and select “Edit camera settings”.
• A window with all stored cameras will appear (Fig. 4-02).

Or :
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4.5  Camera path

• Open the “camera settings” dialog (see chapter 4.4).
• Click the “movement speed” button and select a speed.
• Camera presets (Fig. 4-03) will now use the selected speed for the movement along their trajectories.

o  Instanly: The camera jumps to the selected preset instantly, no path is generated.
o  Fast: The movement speed along the camera path is high.
o  Medium: The movement speed along the camera path is average (this is the default).
o  Slow: The movement speed along the camera path is low.

When you select a camera preset, Store Visualizer will create a trajectory along which the camera will move starting from your current position to the 
selected destination. Store Visualizer will automatically handle acceleration, deceleration and the rotation angle of the camera along the path, so to 
make the movement smooth and natural.

Figure 4-03

A camera path does not handle collision situations with objects in the environment, even if collisions are enabled. When creating 
camera paths through your store, you should position your presets such that no large objects (for example shelving) is blocking the 
trajectory of movement when switching from one preset to the next. Adding a transitional preset between start and end points can 
help avoiding these situations. You can also modify the position of existing presets using the “edit” feature in the camera preset dialog 
(see chapter 4.4).

Use the “camera path” settings to change the speed of movement along the trajectory.
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4.6  Film and lens settings

o  The Lens section defines how the camera optics will see the 3D scene.
             Field of View: Indicates the view angle of the camera lens in degrees. It will be interpreted as 	
               either horizontal, vertical or diagonal opening angle depending on the angle direction settings.   
             Focal lengh: Defines the focal lengh of the camera optics in mm. Several presets are available.

o  The Film format section describes the size of the virtual camera film: 
             Image size: Dimensions and ratio of the virtual film image. 
             Image presets: Several commonly used film size presets are provided.

Figure 4-04

• Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
• Open the “More actions” menu located on the right hand side of the navigation toolbar and select “Film and lens settings”.
• A window with all available camera lens and film settings will appear (Fig. 4-04).
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Figure 5-01

5.1  Current project
You can access and modify the currently loaded project parameters at any time by using the “Current project” panel in the System sidebar tab: 

Figure 5-02

Figure 5-03

Current project > Advanced

Current project > Advanced > Project information > Project

Current project > Author

• Open the “Current project” sidebar panel.

• The Project name is displayed at the top.

• This field contains the “project description”, and can be directly edited.

• The “Advanced” dropdown allows access to project information, project scale and security settings.

• The “Author” button opens the project author and categorization window (Fig. 5-05). 

• Title: The current project name.
• Author: The author of the current project.
• Subject: The subject of the current project.
• Created: Date and time when the project was initially created.
• Modified: Date and time of the last modification.
• More information: Optional comments about the project.
• Category: The optional project category name.
• Keywords: The optional keywords associated with the project.
• Project files: The physical location of the project (vtpr) and scene (3dw) files.

Chapter 5 : Project settings
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Current project > Advanced > Units & Scales

Current project > Author

Figure 5-04

Figure 5-05

• Distance unit: Unit of measure used for distances and surfaces.
• Weight unit: Unit of measure used for weight.

• Author: The author of the current project.
• Subject: Optional project subject. 
• Category: Optional project category name (used for file search by Windows).
• Keywords: Optional project keywords (used for file search by Windows).

This dialog changes the general units used to measure distances, surface area and weight in the current project.
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Chapter 6 : Product manipulation mode

Model libraries

In the Tools sidebar, open the “Library” panel. 
This panel will give you access to your 3D models 
that can be placed into the environment. It also 
offers features to organize, import and manage 
your 3D models.

Model browser

Open the “Model browser” panel. This panel 
shows a graphical 3D representation of the 
models selected in the model library and allows 
the visual inspection of a model before placement.

• Select the object placement toolbar by clicking on the “Object control” icon (Fig. 6-01) located on the bottom panel bar.
• The object placement toolbar appears (Fig. 6-02), and is now active.

Figure 6-01

Store Visualizer exposes three construction modes: product manipulation, shelf creation and store design. Each mode targets a specific process 
in the work flow of creating the layout and shelving of a retail space and filling it up with products.

This chapter focuses on the “product manipulation mode”. This mode is used in both spherical and virtual 3D projects for manipulating and interacting 
with products. A product is defined as any 3D object that is not part of the shelving, store furniture or larger scale construction structure of the store.

Most object manipulation functions shown here (such as movement or creation) are also available in other construction modes. Chapter 8 describes all 
available construction modes used to build your store.

Figure 6-02
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6.1  Using model libraries

The “Project Library”, which is loaded by default into every project, is a special internal library. Its 
contents are stored directly into the project file, while external libraries are merely referenced to. You 
cannot close or specifically save the project library.

• Clicking on the “Library” button will reveal the “External library” management menu:

o  New: Create an empty external library.
o  Load: Load an external library and add it to the project.
o  Close: Close the selected external library.

o  Save: Quicksave the selected external library.
o  Save as: Save the selected library as an external library file.

o  Library settings: Open the external library settings dialog.

o  Show complexity: Shows a complexity gauge in front of every 3D model 
entry, representing the models’ geometrical complexity (see chapter 6.4).

• Import model or resource: Insert an external 3D CAD model file into the library.
• Import image: Insert an external image file into the library.

• Create a new model or resource: Contains the functions for creating new models or resources. See chapter 12 for more 
information.

• Copy: Copy the currently selected entry to the clipboard.
• Cut: Copy the currently selected entry to the clipboard, and remove it from the library.
• Paste: Insert the content of the model clipboard into the library.

• Delete: Delete the currently selected model from the library.

Figure 6-03

• Models: Show or hide all 3D models contained in the library (this should usually be switched on).
• Assemblies: Show or hide all assemblies contained in the library.

Search entries: The search function filters the displayed entries in the library panel according to your 
search terms.
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6.2  Importing an external object
You may import an external 3D CAD object into a library, so to use it as a model within Store Visualizer:

Figure 6-04

• On the sidebar, select the Tools tab, and open the “Library” panel (see chapter 6.1).

• Select the library or folder you would like to add the object to. This can be the Project Library, an external library or any folder therein. You may 
also select an existing model. The new object will then be added to the same library as the selected model. 

• Click on the “Import” icon (Fig. 6-04) or press Ctrl+i.

Store Visualizer can import several standard CAD formats depending on the available import plugins.

• The “Import library model” dialog will open. Navigate through your file structure and select the 3D files you would like to import. Several files 
can be imported at once.

• Confirm your choice by clicking on Open. Cancel will abort the import operation.

• The “Import 3D file” window (Fig. 6-05) will appear. It will enable you to select the import parameters for the 3D models such as shading, lighting 
of models containing light sources, and texture properties.
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• Options:
o Ignore root node: The positional and rotational component of the root transformation is ignored.
o Merge specular maps: If the imported model specifies a secondary specular map, the importer 

will merge it with the primary specular map. This significantly reduces memory consumption and 
improves rendering speed. On rare occasions it may generate slight visual artifacts.

o Modifiable materials: When clicked, all materials used by the imported model will be editable with 
the material editor. See chapter 11 for more information about materials.

• Two sided geometry:
o Never: Never use two sided geometry, even if the 3D file specifically requests it.
o Auto: Automatically decide whether to use two sided geometry or not, following the requests of 

the 3D file.
o Always: Always use two sided geometry, even if the 3D file doesn’t request it. Note that this option 

should only be used in specific cases, such as when dealing with defective 3D files, as it can 
significantly impact performance.

Figure 6-05

• Esko compatibility: Enable support for Esko specific data in Collada files. This will improve the visual 
quality for models exported from Esko software.

The two sided geometry mode can be independently set for opaque and transparent geometry. Two sided faces are generally not useful on opaque 
geometry, unless the 3D designer specifically required them in the design process. They can negatively impact performance, and should therefore 
be disabled. However, they can significantly improve visual quality on transparent materials, and should be enabled by request from the 3D file (Auto 
setting).

Most modern 3D CAD formats supply their own object scale, which Store Visualizer will use. Sometimes however, that scale may be incorrect. Older 
3D CAD formats may not supply a scale at all. In these cases, you can manually specify the object scale using the Override scale option. 

• The file format of the imported 3D model.
If multiple models with different file formats are imported simultaneously, then the import 
parameters (Fig. 6-05) can be individually adjusted for each format.

6.2.1  Model options
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Figure 6-06

Mapping coordinates control the way textures are applied onto the surface of a 3D object. Typically, these coordinates are added when a model is 
designed in a CAD application. Store Visualizer will automatically make use of these coordinates, if they are available.
Sometimes however, you may want to override the original mapping and replace it with your own. Some 3D file formats may not support mapping 
coordinates at all. You can use the mapping options to create and add new mapping coordinates to any imported model.

Checking the “generate custom UV mapping” box will enable mapping coordinate generation. This will override any existing coordinates on the 
imported object. If you would like to use the original mapping coordinates available with the 3D object, then leave this box unchecked.

Store Visualizer supports the following mapping modes:

• Box mapping: this will treat the model as a folded box. All six sides will be equally mapped and unfolded 
onto a common texture image.

• Flat mapping: this will map the model from two sides, which can be selected using the direction axis 
button. This mode is useful for adding two labels (typically front and back) to a relatively thin object, such 
as a flat bottle or a pouch.

• Cylindrical mapping: this mode should be used on cylindrical objects, such as bottles or cans. It will fit a 
circular label around the model and will optionally add top and bottom caps.

Replace material: when checked, the original materials will be removed from the object and replaced by a new material covering the entire model 
according to the selected mapping mode.

Generate caps: This will generate special mapping for the top and bottom caps in cylindrical mode.

Flat direction axis: In flat mapping mode, this drop down button selects the sides the two labels are added to.

Create a pattern: When this is checked, Store Visualizer will generate an image along with your model file, that will contain a pattern of the layout used 
with the selected mapping mode. You can use this pattern as a guide when drawing your own graphics onto the model. These can then be applied to 
the model using the material editor (see chapter 11).

The following options select the resolution of the pattern image file. Note that this resolution is just a base for the pattern image. You can freely modify 
the final image resolution from within your drawing application.

6.2.2  Mapping options
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This settings page controls how lighting and shadows are applied to the 3D object. You may also use this page to change the shader profile used 
for rendering your model. Typically that would be the Physical HDR profile, unless you need backwards compatibility with legacy versions of Store 
Visualizer.

o  Vertex only: Use vertex lighting only (for geometrically complex objects).
o  Vertex and maps: Use both vertex and mapped lighting on the model (for regular objects).
o  Maps only: Use mapped lighting only (for large or geometrically simple objects).

Figure 6-07

• Shader profile: select the shader profile to use for the imported objects.

Ambient lighting simulates self shadowing of objects. Strongly concave objects (for example open 
boxes, trays, displays, etc) will project significant shadows onto themselves. If you look into an open 
box, for example, you will notice that the bottom is much darker that the top part. This is due to self 
shadowing or occlusion. This effect can be simulated with the ambient lighting feature.
Note that ambient lighting can take a considerable amount of time to calculate on complex objects. 
It might also consume a lot of memory at high resolution. Make sure to use ambient lighting only on 
objects where it will be visible. For example typical primary packs, bottles, closed boxes and containers 
will rarely take advantage of the effect, as they aren’t strongly concave. Open containers and shelving 
are the most appropriate type of objects for ambient lighting use.

Disabled Vertex and maps

Disabled Enabled

• Adjust shelf lighting: Option allowing more realistic shadows to be created for store furniture and on 
large 3D models with a complex and concave geometry (such as pallets, certain furniture that is open 
underneath, cars, etc.). 

• Ambient light map resolution and scale: Use this section to change the resolution and quality of the 
ambient lighting. Increasing the resolution will improve quality, but it will also increase the calculation time 
and memory consumption.

6.2.3  Settings
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• Texture resolution: The size selector defines the maximal resolution the object textures will be imported 
at. Larger textures will be automatically resized to the specified maximum size.

Shadow fields disabled Shadow fields enabled

• Shadow fields will make your objects project shadows onto the environment and onto other objects around them. This effect is very important 
for visual realism and should typically be enabled for all objects.

• Detail level controls the resolution of the shadow fields. Unless you are running Store Visualizer on a graphics card with limited memory, it is 
advised to keep this setting on “high”.

• Shadow quality controls the quality of the shadows. A higher quality will increase the preprocessing time, but it will not influence memory 
usage. You can use a lower detail value for quickly evaluating a product. When ready for presentation, reimport it with a higher detail setting.

6.2.4  Lighting

The Lighting section in the “Import 3D file” window enables 3D models containing dynamic light sources to be configured. For further information 
about importing and using 3D models that contain dynamic light sources, please refer to chapter 15.
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The larger the imported 3D file, and the more complex the lighting options, the longer the import 
process will take.

• The imported object appears in the “Library” panel at the chosen place and is shown in the “Model 
browser” (see chapter 6.7).

Figure 6-09

• Once the object is imported without errors, press OK to add it to the model library. It can now be 
accessed as a standard Store Visualizer model.

• Pressing Cancel will discard the imported object without adding it to the library.

Once you have adjusted the import settings to your needs, you can start the actual import process:

• Click on the “Import” button.
• The status tab will automatically open and display the progress of the import process.

Figure 6-08

If a 3D file could not be imported, it will be marked as failed. Select the failed file in the list and click on the 
Import Log button to view more detailed information about the failure.

6.2.5  Status
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6.3  Importing an external image
Images may be directly imported as models. Store Visualizer will automatically map them onto an extruded 3D panel which can be placed into the 
3D environment like any other 3D model.

Figure 6-10

• On the sidebar, select the Tools tab, and open the “Library” panel (see chapter 6.1).

• Select the library or folder you would like to add the image to. This can be the Project Library, an external library or any folder therein. You may 
also select an existing model/image. The new image will then be added to the same library as the selected model/image. 

• Click on the “Import image” icon (Fig. 6-10).

• Confirm your choice by clicking on Open. Cancel will abort the import operation.

• The “Import image file” dialog will appear (Fig. 6-11). It allows you to change the way images are imported, how they are extruded to 3D and 
how their 3D dimensions are obtained. It also specifies how shadows are generated.

• The “Import image file” dialog will open. Navigate through your file structure and select the image files you would like to import. Several files 
can be imported at once.
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o Thickness: Specifies the thickness of the resulting 3D image panel. This value can be zero, resulting 
in a panel without any thickness.

o Pixels per size unit: Determine dimensions automatically based on a fixed pixel size. When using 
this method, you specify how many image pixels fit into a given unit size. The image dimensions will 
then be automatically calculated based on this value. For example, if you specify 100 pixels per inch 
(100 DPI), the physical width of a 2000 pixel wide image will be 20 inches.

o Use embedded physical resolution if available: The PNG file format can optionally contain the 
actual physical size of the image. When checked, Store Visualizer will make use of this data if it is 
available.

o Use fixed dimensions: This method allows the manual specification of the precise physical 
image dimensions, regardless of the image resolution. If only one of width or height is specified, 
the respective other dimension will be automatically generated by using the image ratio. This is 
recommended, as it will avoid distortions. Alternatively, you may also specify both width and height 
manually. Please note that distortions will appear if you do not respect the image ratio in this case.

Figure 6-11

• The imported image appears in the “Library” panel at the chosen place and is shown in the “Model 
browser” (see chapter 6.7).

• The dimensions of the extruded image panel can be determined using the follow methods:

• The size settings define how image resolution in pixels relate to physical model dimensions (in distance 
units such as centimeters or inches) when the image is imported as a 3D model.

When an image with an alpha channel is imported, then a clipping mask will automatically 
be generated. The alpha channel will be used as an opacity mask. The material parameters 
and the use of the alpha channel can be controlled in the material editor (see chapter 11).

6.3.1  Image options
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6.4  Organizing the model library

• You can change the name of a folder or model by typing it into the name area of the “library” panel.

• The Copy/Cut/Paste and Delete icons can be used to move, duplicate or delete the selected models and 
folders within their own or across several libraries. Press the Ctrl key while clicking onto an entry in order 
to select multiple models or folders simultaneously.

• If the “show complexity” function is enabled (see chapter 6.1) a model complexity gauge will appear in 
front of every 3D model in the library. This gauge represents the geometrical complexity of the model. 
Complexity is a function of the amount of polygons in the model and also depends on the visual effects 
used (for example transparency). The higher the complexity of the model, the more the gauge will fill up 
and become red. Adding many complex models to your 3D environment may negatively impact rendering 
performance. 

It is very important to create well optimized 3D models in your CAD application ! Models should 
use the amount of polygons needed for the required quality, but no more. Adding more polygons 
will not improve visual quality, but can significantly degrade rendering performance. Many 3D 
models available on the Internet as part of generic 3D libraries are not well suited for realtime 
simulation.

• Right click on a library (the project library or an external library), a folder, a model or a selection of models 
to open the “contextual menu”. The library contextual menu provides a quick and easy way of accessing 
various frequently used functions.

o 	 Create folder: enables the creation of folders and sub-folders. This function will help you to organize 
large libraries.

• Click on a model to highlight it. This will select it for subsequent operation (eg. object creation) and make it 
appear in the “Model browser”.

Press and hold the Alt key while moving the mouse up and down to drag the selected items 
within the library hierarchy.
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A set number of identical copies or several variations of a model can be quickly created from a previously imported 3D model, without having to repeat 
the import process.

Figure 6-12

Figure 6-13

The model copies created will be separate from the original model.

Right click on a model in a library to open the “contextual menu”.

• Clicking Create copies opens the “Model copies” window (Fig. 6-13).

The Create copies function enables the quick creation of a set number of identical copies of the model selected in the library.

• Type the number of copies that you would like to create and click OK. Cancel will abort the copy creation operation.

• The copies will be created in the library under the original model. They will have the same name as the 3D model copied and will be 
followed by the # symbol and a number.

6.5  Create copies or variations of a model

6.5.1  Create copies
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Figure 6-14

• Clicking Create variations opens the “Select images” window.

The Create variations function enables the quick creation of one or more variations of a model selected in the library, by replacing the color layer of 
one of the materials with one or more images.

• Select the image files that you wish to import to create your variations of the model. You can import several image files simultaneously.

• Confirm your selection by clicking Open.

• The “Model variations” window (Fig. 6-14) will appear. It will indicate the number of variations that will be created. 

Figure 6-15

• Click the drop-down list to display the materials that you can modify (Fig. 6-15). Select the material. 

• Select the “Use the image names for the created models” box, to name the variations based on the name of the selected images. 
If the box is not selected, the variations will have the same name as the 3D model copied and will be followed by the # symbol and a 
number.

• Click OK to start creation of variations. Cancel will abort the variation creation operation.

The list contains the materials with a 
color layer assigned to an image.

6.5.2  Create variations
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You can create customized external libraries that can be reused in different projects and shared between several users. These libraries support all 
features of the project library, including subfolders and hierarchies for easy organization and product classification in larger projects. External libraries 
promote the reuse of data and improve efficiency, since time consuming operations such as object imports become unnecessary.

6.6  Using external libraries

When you create a New library or modify an existing one (eg. copy, move or import models) an asterisk appears 
behind the library name. This is a reminder that you need to save the library in order to keep the changes. Store 
Visualizer will remind you again before closing the project. 

Figure 6-16

You may import an external 3D CAD object into your New library, so to use it as a model within Store Visualizer (see chapter 6.2):

Loading an external 3D library:

The file format extension of library files is l3dw.

• Select the library you would like to add the model to.
• On the sidebar, select the Tools tab and open the “Library” panel (see chapter 6.1).
• Click on the “Import model or resource” icon. The “Import 3D file” dialog will open.

• On the sidebar, select the Tools tab and open the “Library” panel (see chapter 6.1).
• Select Library > Load. The “Load model library” dialog will open.

Creating an empty external library:

• On the sidebar, select the Tools tab and open the “Library” panel (see chapter 6.1).
• Select Library > New. A new empty external library will be created. You may now start adding models or assemblies 

to it (Fig. 6-16).
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The following fields can be used to describe the library. All of these fields are optional.
o  Author: The author of the new library.
o  Subject: Subject of the library.
o  Contents: Library content description. 
o  Comments: General description or comments related to the library.

The detailed texture settings for standard and high priority libraries can be configured in the Preferences > 3D settings > Textures.

This message appears when trying to close a library, and one or several models of that library are 
currently placed in the project environment. By clicking Yes Store Visualizer will remove all instances of 
these models from the project and close the library.  

This message appears when attempting to close a library with unsaved changes or a project containing 
such a library. Clicking Yes will save all modifications before proceeding. No will close the library without 
saving, all changes will be lost. Cancel will abort the operation.

Figure 6-17

o  In order to better control the performance and memory use of very large and complex 
3D products, priorities can be assigned to each imported library. Higher priority products, 
such as the ones from a customer during a presentation, can be displayed at the best 
possible quality level. Regular products, acting as fillers, can be optimized for speed, 
leading to better performance and lower memory consumption.

o  An important library is symbolized by a “green book” on the library icon. The priority 
status can be changed by using the check box on the library settings (Fig. 6-17). 

6.6.1  Saving a project with modified libraries

6.6.2  Settings for Library
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6.7  Using the model browser

While the mouse cursor hovers over the 3D view, you can press and hold the middle mouse 
button to move the object. The mouse wheel will zoom in and out.

Figure 6-18

• The “flag” icon will select all objects in the environment that are derived from the selected model.

Once you selected a model in the library, it appears as an interactive 3D view in the “Model browser” panel. This view helps at inspecting the object 
before placing it into the environment. 

• This informational icon appears if the models contains transparency.

• The “model view options” button opens a list of standard backgrounds for the model browser. You can 
choose between a white or dark pattern, a constant color or a color gradient.

• Model description: This field contains a description of the 3D model. By default, the model import format 
is shown in the description. Click the edit field to change the model description. 

• View or assign model sides defines the front and top sides of the model (see chapter 6.8).

• The box tool will auto-recenter the model, so that it fits perfectly into the model browser view.

• Clicking show model dimensions will display the sizes of the imported model.

• The “refresh” button will reload the model from disk. Use this feature if you modified the original 3D model 
or its texture images, and you would like the model in Store Visualizer to reflect these changes.

• The “show or edit anchor points/anchor lines” buttons open the anchor point and the anchor and snap 
lines dialog (chapter 7.2 and 7.3).

• The “Level of details settings” button allows the adjustment of the LOD mode (see chapter 6.9)

• The “Edit raytracing surfaces” icon allows you to manage the raytracing surfaces used with refractive 
materials (chapter 11.5.6).

• The “Select reflection environment” icon opens a drop-down menu with a series of environments 
available for the reflections applied to the model browser. The model displayed in the browser will reflect 
the environment you have selected. This function only affects the model visible in the browser.
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• Select the side to assign: front or top side of the model. 

• Click on the model face that represents the selected side.

• Currently assigned sides are shown with arrows. The arrow is green for the side you are currently 
editing (front or top).

Many operations in Store Visualizer refer to a specific side of an object: front, bottom or left side for example. In order to function properly, Store 
Visualizer needs to know how your model is oriented with respect to its front and top sides. This information is usually not available in imported 3D 
files, so it has to be manually set.

To easily view and assign the front and top sides of a model, click on the “view or assign model sides” icon in the model browser.

6.8  Assign model sides

Often newly imported models have incorrectly assigned sides. It is important to correct 
these. Typically you will only assign the sides once, after importing a model. Your side 
assignment is stored with your library and can be modified at any time later on, if needed.
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6.9  LOD system

The level of detail (LOD) system dynamically simplifies objects that are far away from the current view, dramatically increasing rendering performance.

While this simplification is barely noticeable on most common objects, some specific 3D models (such as hollow objects like trays or containers) are 
less suited and may display visual artifacts when they are viewed from a distance. Store Visualizer uses an automatic heuristic to detect these models 
and will automatically disable LOD or select a more conservative LOD mode for them.

o Disable: Entirely disable LOD on the model. Only use this mode if the LOD system generates 
unacceptable visual artifacts on the model.

o Enable LOD in reflections: Objects are removed from reflections when they are far away, but no 
other LOD is used for them. Only use this mode if the LOD system generates unacceptable visual 
artifacts on the model.

o  Enable LOD everywhere: Enable the use of LOD on the model. This is the preferred LOD mode.

You can manually select the LOD mode for a model using the LOD settings icon. It is recommended to not 
modify the automatically selected mode unless you encounter heavy visual artifacts, as an incorrectly chosen 
mode may severely degrade rendering performance.



Store Visualizer 18	 57

• Once you have determined the position and orientation of the placement area, press the left mouse button to create a new instance 
of the object at the selected location.

6.10  Placing an object

You can place more than one object by repeating the last two steps as many times as you need. In order to place a different 
model, simply select the new one in the library panel.

o  A green arrow symbolizes the front face of the object. 

o  A yellow arrow symbolizes the back face of the object.

• Each object is derived from a library model. You need to select the model to be used in the library panel.

• On the object placement toolbar, enable the placement mode by clicking on the “Create a new object” icon.

• Move the mouse pointer to the surface you would like to place the object onto. If the placement is possible, a symbolic representation 
of the object will appear.

• You can use the mouse wheel to change the orientation of the object on the placement surface:

Creating an object will automatically switch to the appropriate construction mode. While the examples in this chapter focus 
on product manipulation mode, they will work the same way for models using other construction modes, such as shelves.

• Once you have finished placing objects, press the “Create a new object” icon again in order to disable the placement mode.
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• The “Create on transparent” function allows you to place objects on transparent surfaces. By default, the objects 
are created behind the surfaces.

• When you select creation mode, you can choose how the placement surfaces are managed and how objects are 
positioned on them using the “Placement” drop-down menu.

o  On flat surfaces: You will only be able to create objects on horizontal surfaces. 

o  On any surface: You will be able to create objects on any surface. The object is aligned on the highlighted 
surface.

o  Anywhere upright: you will be able to create objects anywhere without aligning them on the highlighted 
surface.

The Placement and Create on transparent functions are also available when creating an object array (see chapter 6.21).
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6.12  Selecting an object

By default, selected objects are shown with an open yellow box around them. You can change the color of the selection box 
in the preferences. 

• On the object placement toolbar, enable selection mode by clicking on the “Select objects” icon.
• Position the mouse pointer over the object you want to select and press the left mouse button.

• Holding the Ctrl key while clicking the left mouse button will add the object to the current selection.

• Holding the Alt key while clicking the left mouse button will remove the object from the current selection.

• You can select or unselect several objects at once by using a selection area. Clicking the left mouse button, and dragging the mouse 
while holding the button down will create a selection rectangle. All objects within the area will be selected or unselected. 

• Clicking onto an empty area without an object under the mouse pointer will clear the current selection.

6.11  Selecting the construction modes

• Click on the construction mode selector and choose a construction mode to switch to.

Please find detailed information about construction modes in chapter 8.
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6.13  Moving a selection of objects

Usually, movement will be performed along two axes simultaneously. But it can be useful to restrain movement to a single axis, when higher 
positional precision is needed. At least one axis must be selected in order to allow movement.

6.14  Rotating a selection of objects

Rotation can only be performed around a single axis at a time.

• If you press the Ctrl key while still holding the left mouse button, the object will move along the direction perpendicular to the selected 
axes. For example, if the X and Y axes are selected (the default), then the object will move on a horizontal plane. If you press Ctrl, the 
direction will toggle to the Z axis, and you may move the object up and down.

• Enable movement mode by clicking on the “Move selection” icon.
• Movement is started by clicking onto a selected object with the left mouse button, and moving the mouse while holding the button.

• Click on the X, Y or Z axes in order to limit the movement to the requested directions.

• The movement axes are shown by the axis indicator on the placement toolbar:

• Enable rotation mode by clicking on the “Rotate selection” icon.
• Rotation is started by clicking onto a selected object with the left mouse button, and moving the mouse up and down while holding the 

button.

• The rotation axis is shown by the axis indicator on the placement toolbar:

• Click on one of the X, Y or Z axes in order to rotate around the requested axis.

• Pressing the Ctrl key while holding the left mouse button will increase the precision of the rotation.
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6.15  Scaling a selection of objects

Scaling will always change the size of the individually selected objects, and never the size of their parent models in the library.

6.16  Duplicating (cloning) a selection of objects
You can easily duplicate a single object or a set of objects in your project while preserving the original relative positions, orientations and scales:

The cloned objects are completely independend of the original objects used for the duplication.

• Select the object or the objects you would like to duplicate.

• Enable movement mode, as described in chapter 6.13.

• Press and hold the Shift key, and click on a selected object with the left mouse button.

• While still holding both the Shift key and the mouse button, drag the mouse as if you where to normally move the selection as described 
in the chapter 6.13.

• Release the Shift key, but keep holding the left mouse button. The cloned selection is now attached to your mouse pointer, and can 
be moved around freely until the mouse button is released.

• Enable scaling mode by clicking on the “Scale selection” icon.
• Scaling is started by clicking onto a selected object with the left mouse button, and moving the mouse up and down while holding the 

button. By default, scaling is isotropic, ie. it will preserve the axis size ratio of the object:

• Pressing the Ctrl key while holding the left mouse button will increase the precision of the scaling.

• Click one of the X, Y or Z axes to individually select the scaling axis. You will then be able to change the size of objects in an anisotropic 
manner.
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6.17  Auto select
When ”Auto select” is checked, then objects will automatically be selected while using the move, rotate or scale tools, without having to explicitly use 
the selection tool prior to an interaction. The Ctrl and Alt modifier keys for creating multiple selections are also available in this mode (see chapter 
6.12).

Unchecking “Auto select” will freeze the current selection while manipulating objects with the move, rotate or scale tools. 
The selection tool (see chapter 6.12) is used to explicitly change the selection.
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6.18  Pivots and coordinate systems

By default, the object is attached to the local bottom 
pivot, which is most appropriate for standard 
products on horizontal shelves. For products 
hanging from hooks (eg. blister packs), other 
application sides (eg. back) or anchor points should 
be used instead.

In object placement mode, the pivot is graphically represented as a yellow cross, and defines the point at which the object is attached to the 
placement surface. The arrow always shows the bottom - top direction within the local coordinate frame (pointing towards the top):

o  World: Use the global world coordinate system for all selected objects.
o  Local: Use the local coordinate system of each selected object.
o  Parent: Use the local coordinate system of the parent object (if any).
o  Pivot: Use the native pivot coordinate frame of the object (if one was defined).
o  Camera: Use the camera coordinate system for all selected objects.

The transform coordinate system selector defines the reference coordinate frame where all object operations take place in:

o  Center: Set the pivot to the geometrical center of the object or selection.

o  Local origin: Use the local origin of the object as the pivot.

o  Local sides (bottom, top, etc): Use the center of an object side as the pivot.

o  Anchor points: Use a user defined anchor point as the pivot (if one or more anchors were defined). See 
chapter 7.2.

The pivot defines the reference point around which objects are rotated or scaled, as well as the attach point when objects are created. It can be 
changed by clicking on the “Anchor” selector.
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Only the selected objects will be removed, their parent models in the library will not be affected. In order to remove a library model, please 
use the library control features described in chapter 6.1.

6.20  Removing a selection of objects

• Select the object or the objects you would like to remove from the project.

• Open the “More actions” menu located on the right hand side of the object toolbar.

• The “Delete” action will remove all selected objects.

6.19  Replace model

• “Replace model” replaces all objects in the current selection with the model currently selected in the library. You may also press the 
“e” key to replace the model.

The replace tool works on objects and groups created in “Product manipulation mode”, as well as on object arrays.

Alternatively you may simply press the Delete key to remove the currently selected objects. Cmd-Backspace can also be used on the Mac 
version of Store Visualizer.

If you replace a frame or a shelf, please ensure that it does not differ greatly from the old model in order to avoid positioning problems.
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6.21  Multiple object placement

The blue arrow at the edge of the surface cursor represents the FRONT of the filling volume. You may use the 
mouse scroll wheel to change the orientation while still selecting a surface.

The “Object array” feature can be used to quickly fill an area or volume with multiple objects arranged in specific patterns.

You can access and modify the properties of any selected array through the “Object array” dialog.

Use the mouse to select the surface you would like to base the new array on. The blue surface cursor represents the starting 
point of the filling volume. This point is shown as a small blue cross at the center of the surface cursor. 

Release the left mouse button in order to finish the creation of the array. The blue surface positioning cursor will 
reappear and you can continue creating additional arrays. Click the “Create an object array” button again (or press 
‘f’) to leave the array creation mode.

• Make sure the object placement toolbar is currently enabled and select a model in the library. 
• Click on the “Create an object array” icon. The blue surface selection cursor (Fig. 6-19) will appear and the “object array settings” 

dialog will open (Fig. 6-21). 

• Once you have selected a surface and starting point, press and hold the left mouse button. When moving the 
mouse while holding the left button, an outline will appear. This outline defines the volume of space used to 
arrange the objects on the surface. Move the mouse until you are satisfied with the size of the filling volume.

Figure 6-21

Figure 6-20

Figure 6-19

• You can access the array settings dialog at any time by opening the “More actions” menu on the object 
toolbar and selecting “Array settings”. You can also press the Shift-F keyboard shortcut.

• Select the array you would like to modify.

• The parameters of the selected array will appear in the “Object array” dialog (Fig. 6-21) and can be 
adjusted as needed. 

The “Object Array” dialog will open automatically when creating an array.
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6.22  Placement and filling options

• Mode:
o  Even: The spacing between objects will remain the same, taking into account object sizes. 
o  Count: The spacing will be adjusted automatically to keep the number of objects constant.
o  Grid: The objects will be aligned on a regular grid, regardless of object size.

• The three columns represent the X, Y and Z axes respectively. The placement parameters, like alignment 
mode, spacing, or object count, can be modified independently for each axis.

o  Start: Defines the margin between the start of the filling volume and the first object.
o  End: Defines the margin between the last object and the end of the filling volume.
o  Spacing: The empty space inserted between two sucessive objects along the axis (Fig. 6-23b).
o  Random: Sets the amount of random variations applied onto the placement along the axis.
o  Size: Shows the dimensions of a single object in the volume (can not be modified).
o  Extend: The current size of the entire filling volume.
o  Count: The amount of objects inserted into the volume along the respective axis.

• Clicking on “Settings” will allow access to additional array options and features:
o  Allow automatic resizing: Enabling this options allows Store Visualizer to dynamically resize the filling volume extends if more space is 

needed.
o  Delete current array: Removes the currently selected array.
o  Break to objects: Allows access to the individual objects in the filling volume, by making them independent of the array.
o  Fit minimal extend: Refits the extends of the filling volume, so that it encompasses all objects without start or end margins.
o  Generate report: Generates a PDF placement report from the selected array (see chapter 19).

Figure 6-22

Figure 6-23a Figure 6-23b

• The “Object orientation” section controls how individual objects are oriented (rotated) within the array.The preset list contains 
a predefined selection of commonly used orientations. You may also customize the orientation manually through the Azimuth, 
Elevation and Heading fields (Fig. 6-23).

Figure 6-23

• Scale: will change the size of the individual objects within the array, without modifying the extends of the filling volume itself.
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o Random X,Y,Z
o Rotate 118°

6.23  Array randomizer

Sometimes, product sets created with an array will look too ‘perfect’ and aligned for a real world store scenario. Adding random perturbations into the 
process of positioning product onto shelves will improve the realistic aspect of the products. 

Figure 6-24

Figure 6-27

o  Random X,Y,Z : Randomly displaces the objects along the respective axes (Fig. 6-25).
o  Rotate : Adds a random rotation to the objects in the array (Fig. 6-26).
o  Axis of rotation : Selects one or several axes to apply the rotation too.
o  Offset : Randomly moves layers of objects on top of each others.
o  Random snap : Randomly rotates the object by multiples of a fixed angle (eg. randomly rotate in 

steps of 45 degrees) (Fig. 6-27).

• Use the Randomizer function to slightly vary the individual spacing and orientation of objects within the 
object array on the X,Y,Z axes, in order to simulate the imperfections that would be found in a real-life 
context (Fig. 6-25). 

• Randomizer settings:

Figure 6-25 Figure 6-26

• Clutter: The Clutter function allows you to randomly remove a number of objects from the object array.
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Chapter 7 : Anchor points and snapping

It can sometimes be difficult to precisely place an object against another one or attach two objects at a specific point. Hanging blister packs onto a hook 
is a typical example. The anchor function enables an easier placement of an object with an anchor point onto an anchor line. 

7.1  Introduction

7.2  Creating an anchor point

Figure 7-02

The center of the crosshair in 
the gizmo represents the exact 
position of the anchor point.

The entry currently selected in the list of anchor points is the default anchor. A model can have several anchors. Select another anchor 
from the list to make it the default.

• Select the model you would like to add an anchor point to. It will appear in the model browser.
• Click on the “Edit anchor points and lines” icon. Click on “Edit anchor points”. The “Edit anchor points” dialog will open (Fig. 7-01).
• Click on “New entry” to create a new anchor point. It appears in the model browser as a small blue box gizmo near the model. Click on 

the box and drag it to the desired location. 
• Use the “model side view” feature (Fig. 7-02) to help you position the anchor point.

Figure 7-01
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7.3  Creating an anchor line

Figure 7-04

• Select the model you would like to add an anchor line to. It will appear in the model browser.
• Click on the “Edit anchor points and lines” icon. Click on “Edit anchor lines”.The “Edit anchor lines” dialog will open (Fig. 7-03).
• Click on “New entry” to create a new anchor line. The line appears in the model browser with two small blue box gizmos at each end, 

near the model. Click on the end points and drag them to the desired location.
• Use the “model side view” feature (Fig. 7-04) to help you position the anchor line.

Figure 7-03

Anchors lines added to a model are not active by default. Their use as snapping lines can be enabled or disabled on the snap 
settings dialog (see chapter 7.5).
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7.4  Positioning an object with anchors

• Enable object creation mode. Click on the “anchor selector” button and check “Use anchor points”. The default anchor point for the selected 
model will now be used as the creation attach point. See chapter 7.2 if you wish to change the default anchor.

• In the above example, the t-shirt uses an anchor point and the hook an anchor line. When moving the mouse near the anchor line of the hook 
during creation, the anchor point on the t-shirt will snap onto the hook and will be guided along its anchor line. A blue arrow will temporarily appear 
along the anchor line when creating objects.

• Before positioning your model, ensure that the “Anywhere upright” option in “Placement” is selected (see chapter 6.10).

• Select the “Snap to anchor lines” option located in the drop-down menu of the “Snap and alignment settings” button (see chapter 7.5). This 
automatic snapping will facilitate creation of the object.
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7.5  Snap and alignment settings

• Activate the Object placement toolbar by clicking the “Object control” icon (Fig. 6-01) located in the toolbar.

• Click the “Snap and alignment settings” icon to open the drop-down menu (Fig. 7-05).

Figure 7-05

The snap and alignment settings increase the precision of placement when creating objects. The drop-down menu containing the snap settings 
changes depending on the type of model selected in the library (product, shelf panel or shelf frame).

o  Snap to anchor lines: enables use of anchor lines for magnetic snapping when creating objects.

o  Snap to frames: enables magnetic snapping between the shelf frame bases.

o  Snap to walls: enables magnetic snapping between the shelf frames and the main walls present in the 3D 
store environment. 
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Chapter 8 : Construction modes

Store Visualizer exposes three construction modes: product manipulation, shelf creation and store design. Each mode targets a specific process 
in the work flow of creating the layout and shelving of a retail space and filling it up with products.

8.1  Introduction

Figure 8-01

• Select the Object placement toolbar by clicking on the “Object control” icon (Fig. 6-01) located on the bottom panel bar.
• The object placement toolbar appears and is now active. 
• Click on the “Change manipulation mode” button and enable the desired construction mode (Fig. 8-01).

o 	 Product manipulation mode: This is the standard manipulation mode active when you start Store Visualizer. It focuses on the 
manipulation of products on shelves. You will use this mode to place and interact with products in your store and for physical 
simulation.

o 	 Shelf creation mode: This mode is mainly used to quickly modify the shelf configuration within existing units. You can quickly 
access individual shelves, move them and create new ones.

o 	 Store design mode: In this mode you may easily create and manipulate larger shelving units as a whole, creating aisles and doing 
larger scale manipulation of the store layout.

Construction modes relieve you from complex and unintuitive manipulation of the freezing and grouping features of Store 
Visualizer, by fully automating it.

The typical workflow in Store Visualizer would look as follows:

All these steps can be mixed and repeated as required. The following sections explain the steps in more detail.

1) Load a library containing shelf frames, import your own 3D shelf frames or create your shelf frames using the shelf generator.
2) For imported shelves, define shelf type and metrics of the individual parts
3) Design the basic store layout using the store design mode
4) Adjust shelving in the shelf creation mode
5) Place your products on the shelves
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8.2  Store design mode

• Enter Store design mode by pressing the button on the toolbar or by selecting a shelf frame model in the library and enabling creation 
mode.

You may now select and manipulate large shelving units as combined blocks. An optional snapping mode is available for quickly 
and accurately aligning units and creating aisles. When selecting a unit, all shelves and products positioned onto the shelves are 
automatically selected and will be moved along.

The snap between shelves function can be enabled or disabled by clicking the “Snap and alignment settings” icon and by 
selecting “Snap to frames” in the drop-down menu (Fig. 7-05).
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This mode allows the manipulation of individual shelves within a unit. A special shelf snap is available for extremely easy creation 
and positioning of shelves. Products placed on a shelf can be automatically moved with the shelf without additional selection.

8.3  Shelf mode

• Enter Shelf mode by pressing the button on the toolbar or by selecting a shelf model in the library and enabling creation mode.

The precise positioning of shelves within a frame is controlled by the shelf metrics.
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8.4  Product manipulation mode

• Enter Product manipulation mode by pressing the button on the toolbar or by selecting a standard model in the library and enabling 
creation mode.

Enabling this mode will automatically freeze all shelving, so to not interfere with your product interaction. It will also automatically 
re-enable physics, which were disabled during store and shelf construction.

• Once you are satisfied with the placement and configuration of your shelves, enter product manipulation mode. This is the standard mode 
allowing you to place and interact with products on shelves (see chapter 6). 
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8.5  How to build a complete store?

1. Store design mode
2. Create and manipulate your shelf frames
3. Create the layout of your store according 
to your floor plan. Create aisles, add displays 
and branding elements to your store

4. Shelf creation mode
5. Create and manipulate your shelf panels, 
hook racks, baskets, etc

6. Product manipulation mode
7. Create and manipulate your products
8. Fill up your aisles with products

In addition to the manipulation mode selector on the object placement toolbar, a quick mode switch and keyboard 
shortcuts are available. 

When in either shelf creation mode or in store design mode, a respective icon will appear on the top left corner of the 
screen. Clicking this icon will open a menu with quick access to the three construction modes.

This feature is particularly useful when working in fullscreen mode and with hidden user interface.

8.6  Quick mode switch

The keyboard shortcuts F2 to F4 can be used to switch construction modes.
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When a model is imported into Store Visualizer, it is considered a standard model / product by default. As such, it will be available in “product 
manipulation mode”. If the imported model represents a shelf, a component of a shelf or a component of the large scale store infrastructure, then it 
will have to be declared as such to make it available in the appropriate construction mode and to have the correct shaders applied.

8.7  Defining and adjusting shelf models

Shelving models provided with Store Visualizer are preconfigured and do not require any further adjustments. If you import your own 
shelving models and need assistance in optimally adjusting the metrics for best quality, then we recommend contacting your reseller about 
available training options.

Figure 8-02

Figure 8-03

• Select the 3D model in your library.

• Click on the “Edit shelf metrics” button to choose / change the model type. The 
“Shelf metrics” dialog will open (Fig. 8-02).

o 	 By default a 3D model imported into Store Visualizer will be a standard model. 
You will have to change the type if your model is not a product, so to make it 
available in other construction modes.

• Once you have selected the model type, you may proceed to adjust its metrics.

o 	 Select shelf frame if your model is a shelf frame, a support, an individual 
backplate or any other shelving unit with a closed backpanel.

o 	 Select shelf panel if your model is a shelf panel, a basket rack or similar.

o 	 Select shelf hooks if your model represents a hook rack.

o 	 Select Generic furniture if your model is a table, display fridge or similar 
furniture.

o 	 Select structural component if your model will be a part of the store geometry 
(walls, doors, banners, etc). The lighting shader is adapted when this model type 
is selected, so to offer maximal visual quality for large scale elements.

o 	 Select Shelf component if your model is a component, whether or not it attaches 
to the shelf or panel.
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8.8  Layout view

Click on the “layout view” button again or press ‘t’ to switch back to standard 3D view.

• Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
• The navigation toolbar appears.

• Click the “Toggle layout view” icon to activate or deactivate the layout view.

o 	 Use the mouse wheel to zoom in and zoom out. You 
can also move the “View height” slider to quickly 
position the view at a given height.

o 	 Press space to toggle “freelook mode”. While in 
freelook mode, move your mouse or press the arrow 
keys to move around.

o 	 Use the standard object manipulation tools of Store 
Visualizer to interact with the objects in your store.

Figure 8-04

When layout view is enabled, your current project will be presented from a top-down perspective (Fig. 8-04). This floor plan view mode is very useful 
when editing the layout of your store on a larger scale, such as creating aisles, defining areas or changing large structural store components. 
When layout mode is active, Store Visualizer will jump to store design mode by default. While this is the most commonly used mode for floor plan 
editing, you may use any desired construction mode while in layout view.

o 	 Press the “Reset view position” icon to move the 
view to a default position.
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8.9  Shelf positioning
The shelf positioning dialog allows access to all shelf related data in a unified way. You can use this dialog to precisely adjust the heights and distances 
of individual shelf panels and to view additional meta-data associated with the products positioned on each shelf.

• Select the Object placement toolbar by clicking on the “Object control” icon (Fig. 1-01) located on the bottom panel bar.
• The object placement toolbar appears and is now active. 

• Open the “More actions” menu and select “Edit panel positions”. The panel positioning dialog will appear (Fig. 8-05).
• When a shelf is selected in Shelf manipulation mode (see chapter 8.3), its associated positioning and meta data will automatically 

appear in the shelf positioning dialog.

Figure 8-05

o 	 The shelf column lists or shelves available in the current unit, 
including the bottom shelf.

o 	 The distance column shows the distance of the respective shelf 
panel to the one just below it. You can edit and modify this value 
by double clicking on it.

o 	 The height column shows the absolute ground height of the 
respective shelf panel. You can edit and modify this value by 
double clicking on it

Selecting a shelf entry in the list will automatically select it in 
the 3D environment. Double clicking on a product entry will 
select all products of the specified type on the shelf and will 
switch to product manipulation mode.

Shelf entries in the list can be opened by double clicking on them. 
Below each shelf entry the amount of products placed onto the shelf is 
listed, aggregated by type. Selecting a product or shelf entry will display 
additional meta data about the item.

o 	 Products: Total amount of products on the selected shelf entry.

o 	 Weight: Total weight of the selected product entry (see chapter 
16.5 about assigning model weights).

o 	 More meta information can be displayed depending on the installed 
plugin modules.
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Chapter 9 : Assemblies

Combinations of objects can be joined together into assemblies and stored in a library. This allows the storage and easy reuse of constructions involving 
multiple objects, groups and arrays.

9.1  Creating an assembly

Figure 9-01

Don’t forget to assign the front and top sides of a new assembly, in the same way as you do for newly imported models (see chapter 
6.8) !

Figure 9-02

Assemblies act as blueprints. They contain the instructions needed to build the object construct they represent, but they do not directly contain the 
models. Instead, they reference models in the same or in another external library. If these models are unavailable, then the assembly referencing them 
is considered broken and cannot be built (see chapter 9.3). Loading an external library containing the referenced models will automatically repair all 
assemblies using them.

• Select the library you would like to add the new assembly to (in the library panel, see chapter 6).
• Select the objects you would like to combine into an assembly. In this example, a shelving unit with one shelf panel (Fig. 9-01).
• Right click to open the contextual menu and select Assembly > Create new assembly.
• The assembly will be created in the “Assemblies” section of the library you selected earlier (Fig. 9-02) and will appear in the model browser 

when selected.
• You can now create instances of this assembly using the normal object creation tool (see chapter 6.10). The object construct represented by 

the assembly will be recreated in your 3D environment. Once created, the new objects will be independent of the assembly they originated 
from.
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An existing assembly can be modified or updated with new content at any time.

9.2  Updating an assembly

Figure 9-03 Figure 9-04

• Select the assembly you would like to update in the library panel.
• Select the objects that will replace the contents of the selected assembly. In this example, the original assembly will now be updated by a 

shelving unit with multiple shelf panels (Fig. 9-03).
• Right click to open the contextual menu and select Assembly > Update assembly.
• The assembly will now contain the new object construct.
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9.3  Incomplete assembly
An assembly is considered incomplete when one or more models required to reconstruct the combination of objects cannot be found in the libraries 
loaded, either because they have been deleted or because the assembly contains models found in a library that has not been loaded. 

Figure 9-05

Figure 9-06

Figure 9-07

If the models present in the incomplete assembly have been deleted from the library, you will have to recreate the assembly.

• In the “Assemblies” section of the library, an icon will appear in front of the incomplete assembly (Fig. 9-05).
• In the “Model browser” (Fig. 9-06), a red notification “Assembly is incomplete!” warns you that the assembly does not contain all of the 

objects that were used to create it. The “Model browser” displays the assembly as is without the missing objects.

• Click the “Assembly is incomplete!” notification to open the Broken assembly window (Fig. 9-07). This window contains a list of objects 
missing in the assembly.

• Load the external library or libraries containing the models referenced in the assembly so that it can be automatically repaired.

However, you can still create instances of this incomplete assembly by using the normal object creation tools (see chapter 6.10).
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Chapter 10 : Using the scenegraph

The scenegraph is a tool that regroups all interactive elements present in the current project. Its purpose is the organization of the structure and the 
relationship between project elements.

•  Select the Scene tab on the sidebar and open the “scenegraph” rollout (Fig. 10-01).

10.1  Introduction

o  Store: Contains all modifiable structural elements of the store.
o  Shelves: Contains all the shelving present in the store.
o  Products: Contains all the products placed onto shelves and into the store.
o  Helpers: Contains all helper gizmos.
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10.2  Scene elements

o  The “Array” icon represents an object array. Clicking on it will change the visibility: 
		   If the icon is blue (active) then the associated array is visible.
		   If the icon is gray (inactive) then the associated array is hidden.

Displays a list of all elements of the project and shows their hierarchical relationships. You can individually mark items by clicking on them with the left 
mouse button. Use the Ctrl key to mark several items. Click the right mouse button to open a context menu for the marked elements, see chapter 10.8.

Figure 10-01

o  The “Object” icon represents a single object. Clicking on it will change its visibility: 
		   If the icon is blue (active) then the associated object is visible.
		   If the icon is gray (inactive) then the associated object is hidden.

o  The “Group” icon represents an element group. Clicking on it will change the group visibility: 
		   If the icon is blue (active) then all elements of the group are visible.
		   If the icon is gray (inactive) then all elements of the group are hidden.

o  A group may be closed or open. The latter case is reflected by a changed group icon.

o  The “Flag” icon displays which element is selected in the 3D scene. Click on it to select or unselect the 
associated element:
		   If the icon is red (active) then the associated element is selected.
		   If the icon is gray (inactive) then the associated element is unselected.

o  Scenegraph control panel. For details, see chapter 10.4.

o  The Search entries function filters the entries displayed in the scenegraph by name.

o  Frozen elements cannot be selected or manipulated. This state is indicated by a “Lock” icon and a 
grayed out name. (See chapter 10.6)

o  The Store section contains all structural elements (chapter 8-07). 
o  The Shelves section contains all Shelf frames and Shelf panels in the store.

All objects in the products section will automatically be grouped according to the shelf they 
are placed on. This grouping adapts automatically when moving a product from one shelf 
to another.

Store Visualizer will automatically group shelving units. It is not recommended to modify 
this grouping!

o  The Products section contains all Products in the store.

o  The “Filter entries” icon opens advanced filter functions (see chapter 10.3).
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10.4  Scenegraph control panel

The control panel is located below the scenegraph. It contains functions used to manipulate and restructure scenegraph elements.

o  Select none: Clears the current selection.

o  Select all: Selects all elements in the scenegraph.

o  Show or hide objects: See Fig. 10-02.

o  Freeze or unfreeze object: See Fig. 10-03.

o  Toggle group mode: Opens or closes a group.

o  Group objects: See chapter 10.7.

o  Dissocate current group: Dissociate a group.

o  Explode group: Explode the hierarchy below a group.

In addition to filtering scenegraph entries by name, the advanced filter options allow the entries to be filtered by various object related states. You can, 
for example, display only selected objects or only frozen ones.

10.3  Filter entries

• Select the type of advanced filter from the drop down to enable it.

• Changes of object states in your project will not automatically affect the currently displayed entries when an 
advanced filter is enabled. Press the “Refresh filter” icon to propagate any changes to the filtered entries.

	 As an example, the ‘selected objects’ filter will display all entries that are selected at the time you enable the 
filter. If you subsequently modify the selection, the entries shown in the scenegraph will not change. Pressing 
refresh will update the filter to the new selection.

• Uncheck the filter icon to disable an advanced filter.
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10.5  Show or hide objects
The show or hide objects button regroups features to modify the visibility states of one or several elements in the scenegraph.

o  Show all: Unhides all hidden elements.
o  Show selected: Unhides only the currently selected elements.
o  Hide all: Hides all elements in the scenegraph.
o  Hide selected: Hides only the currently selected elements.

Figure 10-02

10.6  Freeze or unfreeze objects

By freezing an element all interactions with the object are temporarily disabled. An object should be frozen to avoid accidental manipulations such 
as movements or rotations while interacting with other objects nearby. 

o  Freeze marked: Freeze the currently marked scenegraph element.
o  Freeze selected: Freeze the currently selected elements.
o  Freeze unselected: Freeze all objects that are not currently selected.
o  Freeze all: Freeze all objects in the project.
o  Unfreeze marked: Unfreeze the currently marked scenegraph element.
o  Unfreeze all: Unfreeze all currently frozen objects.

Figure 10-03

Right clicking on an entry in the scenegraph will open a contextual menu offering an easy access to the most commonly used functions.
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Click on the “Group objects” icon to open the group drop-down menu. The context menu also includes these functions.

The new group will appear in the scenegraph above its member elements. You can easily change its default name by using the name field 
on the top of the scenegraph area. 

A group of elements can be dissociated, rendering all member objects separate again. 

Removing a group will not remove any of its member objects ! It will only break the logical link between them. The dissociated member 
elements can be regrouped at any time.

10.7  Using groups
Elements that are logically or physically linked together can be placed into a group. Manipulations performed on the group will be applied to all 
contained member elements simultaneously. The relative distances between all group members are preserved. All object types are groupable. Groups 
can also be nested, creating subgroups. 

• Select the group to dissociate and press the “Dissociate current group ”. Again, this action can also be performed by using the context 
menu.

The explode group function can be used to completely dissociate all member elements and subgroups of a group at once, through the entire 
hierarchical branch.

Exploding a group will not remove any of its member objects except subgroups ! It will break the logical link between all elements in the 
group and all of its sub groups.

• Select the group to explode and click on the “Explode current group” icon. The same features is available through the context menu.

o  Group marked objects: groups all the elements marked in the scenegraph.

o  Group selected objects: groups all the objects selected in the 3D scene.

10.7.1  Creating a new group

10.7.2  Dissociate current group

10.7.3  Explode current group
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10.8  Scenegraph context menu
The scenegraph context menu provides a quick way to access commonly used functions when one or more items are marked (highlighted in blue) in 
the scenegraph. Use the Ctrl key to mark several elements.

• Right click on one or more models in a library to open the “context menu”. 

o  Select: selects all the elements marked in the 3D scene of the scenegraph.

o  Unselect: unselects all the elements marked in the 3D scene of the scenegraph.

o  Freeze: freezes all marked elements.

o  Unfreeze: unfreezes all marked elements.

o  Group: creates a group with all the elements marked in the scenegraph. 

o  Ungroup: ungroups all marked groups.

o  Open group: opens all marked groups.

Figure 10-04
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The object context menu offers an easy and quick way to access several commonly used features.

10.9  Context menu of objects in the 3D scene

o  Move: Enables object movement mode.
o  Rotate: Enables rotation mode.
o  Scale: Change the object size.

o  Transform: Selects the axes affected by movement, rotation or scale operations.
o  Assembly: Create or update an assembly from the selection (see chapter 9).

o  Hide: Hide an object.
o  Freeze: Freeze an object.
o  Delete: Delete all selected objects.

o  Group selection: Group all selected objects.
o  Ungroup: Dissociate a group.
o  Explode: Dissociate the hierarchy below a group.
o  Open group: Open / close a group.

o  Hide selection: Hide all selected objects.
o  Freeze selection: Freeze all selected objects.

o  Model to library: Select the model of the object in the library.
o  Product viewer: Enable product view mode on the selected object (see chapter 17).

•   An object array offers additional options in its context menu (Fig. 10-06)

• Right click onto an object or a selection of objects to open the context menu: 

o  Break to objects : Allows access to the individual objects in the filling volume, by making them independent of    
the array.

o  Fit minimal extend : Refits the extends of the filling volume, so that it encompasses all objects without start or 
end margins.

Figure 10-05

Figure 10-06
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Chapter 11 :  Material editor

• On the sidebar, select the Scene tab, and open the “Material editor” panel. Fig. 11-01 will appear.
• Select a model from a library. A list of the materials making up the model will appear in the “Material editor”.

Only models that were initially imported with the “Modifiable Materials” option checked will allow access to their materials. See 
chapter 6.2 for more information about this option.

Store Visualizer allows you to easily modify the visual appearance of a 3D model. You can edit the surface color, assign artwork, change the reflectivity 
or select a different material for your model. The material editor regroups these options in a central location.

Figure 11-01

o Material: The top section of the material editor panel lists all materials available in the currently selected model. 
Click to select the material entry you would like to modify. Double click on an entry to change the material name.

o 	Pick a material from a model: If this function is activated, click a material directly on a model displayed in the 
model browser or an object positioned in the scene to select it. The material will be briefly highlighted and its 
properties displayed.

o 	Material actions: Opens a drop-down menu for copy operations.

You can also press the shortcut key “k” to quickly select a material on a model.

o 	The drop-down “Material shader “ menu lists the shaders applicable to the material. Additional extensions may 
provide other types of shader.

The colour of the icon in front of the material name represents the shader applied to the material (see 
shader list below).

 Standard HDR: The default shader used for Store Visualizer packaging models. 

 Disabled: Makes it possible to disable a material. The parts of the model using disabled 
material will become invisible. 

 Refractive: Applies the refractive shader to the selected material. See chapter 11.5 for more 
information on refraction. 

o 	Material presets: Opens the “Material presets” window showing a list of materials supplied with Store Visualizer 
as well as customized materials (see chapter 11.7).
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o 	Surface appearance: This section describes the color and reflective properties of the material (see chapter 11.1 
and 11.2).

o 	Transparency: This section controls the transparency and translucency of the material (see chapter 11.3).

o 	Clipping mask:  (see chapter 11.3.1).

o 	Shadow: Use the shadow intensity control to change the strength of the shadows generated by objects created 
from this model.

o 	Reflect: Uncheck “Reflect” if objects created from this model should not be visible in reflections (this can improve 
performance).

o 	Advanced settings: This section covers more specific and advanced material settings, see chapter 11.4.

o 	 Image viewer: Pressing one of the viewer buttons will display the image currently assigned to the respective layer.

o 	Modify image: These buttons will open the layer image modification window for the respective layer (see chapter 
11.5).

o 	Transparent lighting effects: Enables or disables the shadows and dynamic lighting on the transparent surfaces 
of the selected model.
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11.1  Surface appearance

This section allows you to specify the color and the reflective properties of the surface. These properties are vital in defining the visual appearance 
of a material. By simply changing the following settings, you can create a wide range of materials such as paperboard, plastics, metals, glass and 
much more.

The color layer will add a constant color or a color image to your models, like for example a label:

No color Color imageConstant color

The reflect field controls the overall surface reflectivity, ie. how reflective your model is. A low value will create a rough and dull surface material, such 
as paper. A medium value will simulate varnished or coated surfaces, as well as smooth materials like plastics. Very high values, up to 100%, will 
simulate mirror like reflections, such as from metals.

Reflect: 0 Reflect: 100%Reflect: 50% Reflectivity image
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The gloss field changes the glossiness of the reflection. A value of zero represents a very matte surface, while a value of 100 will make your model 
extremely shiny.

Gloss: 0 Gloss: 100%Gloss: 50% Glossiness image

Each of these layers (color, reflect and glossiness) can also be controlled by an image. Applying an image to the color layer will, for 
example, add a graphical artwork to your model. See chapter 11.6 for more details on layer images.

11.2  Embossing
You may add embossing or a relief to your model by using this section. The embossing mask is supplied as a grayscale layer image. The strength of 
the embossing can be controlled by changing the scale field. Both positive and negative embossing can be simulated. Use a negative scale value to 
flip the direction of the embossed areas (inwards becomes outwards and vice-versa).

No embossing Negative embossingPositive embossing
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11.3  Transparency

Opacity: 100% Opacity: 25%Opacity: 50% Opacity image

A model can be transparent, such as one made of glass or transparent plastic, or can have translucent parts. This section controls the opacity of the 
material (how much light is absorbed) and its color. An opacity value of zero will create an entirely transparent material, while it will be fully opaque 
at 100%.

Adding a transparency filter will create a material that tints anything seen through it (such as green bottle glass, for example). Two filter modes are 
available: color and layer. A color filter works with a single user supplied color, while a layer filter uses the color surface layer.

No filter Layer filterColor filter
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Store Visualizer supports a special transparency mode, available through the “clipping mask“ checkbox. When enabled, fully transparent parts of the 
opacity image will be entirely cut away from the rendered image. This mode is useful if the opacity image (or the alpha channel of the color image) 
contains a contour or shape mask rather than an actual transparency. A typical example is a shaped label.

o Without clipping mask: The transparent parts around the label are rendered as a fully transparent material. The label appears as if it was 
printed on a sheet of transparent plastic.

o 	With clipping mask: The transparent parts around the label are cut away. The label appears correctly.

Without clipping mask With clipping mask

Using clipping masks instead of normal transparency can improve rendering performance. It should always be used if the 
transparency layer of a material represents a mask or a clipping path. However clipping masks should never be used if the 
material contains semi-transparent areas or if actual transparency is needed.

11.3.1  Clipping mask
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11.4  Advanced settings

This section gives access to advanced optical properties of the material, altering the way light interacts with it. These properties are required to make 
certain types of materials more realistic. Depending on the selected shader, this section may contain additional parameters.

o 	Secondary specular: Certain multi-layered materials, such as some metallic paints, use a second reflective 
layer below the main one, with different reflective properties and color. This typically results in a hazy and colored 
reflective halo surrounding the main sharp white reflection.

o 	Fresnel: Certain materials exhibit an optical phenomenon called the Fresnel effect. In these materials, the strength 
of the reflections changes with the viewing angle. A varnished wooden floor, for example, may only be moderately 
reflective when seen from above, but will almost turn into a mirror when viewed at a shallow angle. You can control 
the Fresnel effect by changing the value in the Fresnel spinner. At 100%, reflections are independent of viewing 
angle, and there will be no Fresnel effect. At 0%, the effect will be very visible through a strong dependency on 
viewing angle.

o 	 Falloff: The falloff effect simulates view dependent absorbency within transparent materials. The effect can be 
used to improve the visual realism of hollow objects made from a refractive transparent material (glass bottles, for 
example). When increasing the falloff value, the outline of a transparent object will look increasingly thick. A value 
of zero disables the effect.

o 	Metallic reflections: Metallic materials will tint their reflections while other type of materials will not. A gold bar, 
for example, will have gold colored reflections, while a blue plastic bottle will not have blue reflections. This option 
should be enabled if you are simulating a non-varnished metallic surface.

o 	Glossiness in reflect alpha: When enabled, the glossiness layer will be sourced from the alpha channel of the 
reflectivity layer image.  

o 	Opacity in color alpha: When enabled, the alpha channel of the color image layer will control the opacity of the 
material.

o 	Color correction: Use these settings to modify the hue and saturation of the base material.
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11.5  Refraction
The refraction shader uses realtime raytracing to simulate transparent and refractive materials such as glass and liquids in a photorealistic way. 

• Click on the “Material shader” drop-down menu and select the “Refractive” option. The “Material editor” will display the refraction options (Fig. 
11-02).

This option is only available for models imported from SSV16.1.1. Models imported into earlier versions 
of the software must be reimported.

Figure 11-02

o 	Refraction: This section controls the refraction parameters of the volume or container (see chapter 11.5.2).

o 	Color overlay: Applies a color overlay on the refractive part (see chapter 11.5.1). See chapter 11.6 on layer 
management.

o 	Correct problems with the geometry of the bottom: Some 3D models may have modelling defects that will alter 
the refraction effect, especially in the bottom of the model (the bottom of a bottle for example). By activating this 
function, some of these defects can be corrected. 

o   By default, the refractive material will simulate a container with a liquid inside. Other types of refraction are possible. 
Open the drop-down menu to select the type of refraction you want to apply to your material.

 Refractive volume: Simulates a refraction volume without liquid, such as a solid 
block of glass for example.
 Container with liquid: Simulates a refractive container with liquid inside.

 Container inner wall: Carves out the refractive volume to make space for a liquid. 
See chapter 11.5.5.

o 	Liquid: To obtain a perfectly realistic refraction, we simulate a liquid in a procedural way. This section controls the 
refraction parameters and properties of the liquid (see chapter 11.5.3).

o 	Multilayer refractions: See chapter 15.5.4

The visual effects associated with refraction are not visible in the “Model browser” but only in the 3D 
scene.
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11.5.1  Color overlay
This function allows you to apply a color overlay on the refractive part of a model. This will allow you to add, for example, a label or a layer printed 
directly onto the refractive surface.

o 	Color: Allows you to change the opacity of the color overlay. A value of 0% will make the overlay completely 
transparent while a value of 100% will make it opaque. The opacity of the overlay will also be affected by the 
alpha channel of the image assigned to the color layer.

o 	View color image: Opens the “Texture viewer” window with additional information on the color map, such as 
the image alpha channel, image resolution, etc.

o 	Add or modify color map: Used to manage the color overlay layer. See chapter 11.6 for more information on 
layer management.

Without color overlay With color overlay

The image format imported in the color overlay must include an alpha channel used for the opacity mask (image formats with alpha 
channel: png, tif, tga). 

RGB channels

Alpha channel
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11.5.2  Refraction parameters

o Fresnel: The Fresnel field controls the reflectivity of the model surface. A low value will create a shiny surface, a high value a metallic 
appearance.

This section controls the refraction parameters of the volume or container.

Fresnel: 0% Fresnel: 5% Fresnel: 25%
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o Filter: The color filter changes the color of the refractive material. You can modify the filter power by modifying the value field to the right of 
the color selector.

Filter: white 0.10 Filter: green 5.00 Filter: green 15.00 Filter: white 0.10 Filter: blue 5.00 Filter: blue 35.00

o IOR: The refractive index of the material. You will find common IOR values in the drop-down menu to the right of the value field. 

IOR: 1.00 Air IOR: 1.15 Plastic IOR: 1.50 Glass
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11.5.3  Parameters of the liquid
It is possible to add liquid to your container in real time and to animate it when you move it.

If your container already has a liquid modelled in 3D, you must first disable this material or put it in the “Container inner wall” (see 
page 97).

o  Volume: Represents the volume of liquid in the container as a percentage.

o IOR: The liquid refractive index simulates the behavior of the light in liquids. You will find common IOR values in the drop-down menu to the 
right of the value field.

Volume: 00% Volume: 50% Volume: 95% Volume: 00% Volume: 55% Volume: 75%
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o 	Viscosity: A function that allows you to animate the liquid in a refractive container. By default, viscosity simulation is disabled. Select the 
viscosity of the liquid from the drop-down list to activate simulation. When you move the object, the liquid will move according to the viscosity 
selected.

o Filter: The color filter allows you to modify the color of the liquid. You can modify the filter power by modifying the value field.

Filter: red 0.50 Filter: red 1.50 Filter: red 5.00
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11.5.4  Multilayer refractions
Some models made up of highly concave parts may present rendering artefacts in the refraction. In the example below, the foot of the glass is not 
visible through the top of the glass. The multilayer refraction function makes it possible to compensate for this.

Multilayer disabled Multilayer enabled

11.5.5  Container inner wall

Without inner wall
Solid block of glass

With inner wall
Hollow area inside

Example: You import the model of a bottle. The internal liquid is modeled as a separate object and 
material. You will need to define this material as an inner wall, so that the modeled liquid creates a 
hollow space inside the body of the bottle. Otherwise, the bottle will be treated as a single block of 
solid glass.

If the imported model has an empty space inside the refractive part, and this hollow part is modeled by geometry using a different material to that of 
the refractive volume, then this material must be defined as an inner wall. This will carve out the refractive volume and allow you to fill it with liquid. If 
the material of the inner hollow part is identical to the material of the refractive volume, then the inner wall assignment will be automatic.

Refractive models imported from Esko tools intended for Keyshot rendering will always 
have a modeled liquid that will have to be defined as an inner wall.
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11.5.6  Raytracing surfaces
By default, the elements visible through a refractive object come from the reflection sphere in which it is located. If the refractive object is close to other 
objects (e.g. a transparent bottle on a table), the latter will not be visible through the refractive object. See chapter 11-03.

The raytracing surfaces will increase the realism of these situations. For a nearby object to be visible through a refractive material, one or more 
raytracing surfaces must be applied. The raytracing surfaces generally apply to models close to refractive objects and not to refractive models 
themselves!

Raytracing surfaces are generated automatically when you create a shelf frame or shelf panel (chapter 12) or when you import a 
model and define it as a shelf frame or shelf panel support (chapter 8.7). You do not need to create them manually in these models, 
but you can still modify them or add more.

In the example below, we see a glass bottle on a table. By default, the table will not be visible through the bottle (Fig. 11-03). By adding a raytracing 
surface to the table, it will become visible through the refractive object (Fig. 11-04). Note that there is no raytracing surface on the bottle!

Figure 11-03 Figure 11-04

A raytracing surface is applied to the table and another raytracing surface is applied to the cardboard model.
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• In the library, select the 3D model to which you wish to assign one or more raytracing surfaces. The 3D model 
appears in the “Model browser”.

11.5.7  Create and modify raytracing surfaces

A 3D model may have several raytracing surfaces. For best performance, we recommend you only add the surfaces required to 
obtain the desired visual effect. If your graphic card permits, you can increase the number of raytracing surfaces when rendering: 
Preferences > 3D settings > Transparency and refraction > Raytracing > Amount of surfaces.

• In the “Model browser”, click on the “Edit raytracing surfaces” icon (Fig. 11-05). The “Raytracing surfaces” 
window opens (Fig. 11-06). This window contains a list of all raytracing surfaces linked to the 3D model selected 
earlier.

Figure 11-05

Figure 11-06

o 	Add new entry: Add a new raytracing surface to the selected model. When the icon is clicked, it turns red 
(Fig. 11-07) and invites you to select a surface in the model browser. Click the left mouse button on the 
desired 3D model surface (Fig. 11-08). A blue gizmo, representing the raytracing surface, appears on the 
selected surface (Fig. 11-08).

Figure 11-07 Figure 11-08
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o 	Remove entry: Deletes the previously selected raytracing surface from the list. 

o 	Pick surface: When a raytracing surface has been assigned incorrectly, select it from the list and click 
on the Surface selection icon. The icon turns red and you can select a new surface on the model. 

o 	Automatic surface adjustment: If you click on the icon when selecting the surface in the model 
browser, the dimensions of the raytracing surface created will be adjusted automatically.
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Figure 11-09

11.6  Layer images
Each of the aforementioned material layers (color, reflect, gloss, embossing and opacity) can be controled by an image. Press the edit image layer or 
the add image layer button next to the respective layer, as shown to the left. The image layer control window will appear (Fig. 11-09).

• Press the “Edit image layer” or the “Add image layer” button next to the respective layer.

o Enable: Checking this box will enable the respective image layer

o Image selector: Press the image selector button in order to load and apply an image to the layer.

Pressing the Ctrl key while operating the move or size spinners will increase their precision 
for fine tuning.

o Lock layer: When pressed, the position and size of this layer will automatically follow any modifications 
applied to the color layer.

o Channel: The UV mapping channel used by this layer. Store Visualizer supports up to 16 independent 
channels. By default the first available channel is used.

A small preview of the current image is shown on the right hand side of the image layer window. If 
you would like to see a larger preview or get more information, use the “Image viewer” buttons to 
the right of each layer entry in the material editor panel.

The maximum resolution of loaded images can be adjusted in the Preferences under 
Plugins > Material editor > Texture resolution.

o X/Y Move: Reposition the layer by moving it horizontally and vertically.
o X/Y Size: Change the horizontal and vertical dimensions of the layer.

o 	Save Image: Saves the image on your hard drive. 

o 	 Information: Displays the name, type and resolution of the image. “Display information about 
the image” is activated by default.
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Figure 11-10

Press the “Image selector” button to open the “Image loading” dialog. Store Visualizer supports all commonly used image formats such as jpeg, 
png, tiff, pdf and more.

o 	 Invert alpha channel: If this option is clicked then the system will invert the alpha channel of the loaded 
image.

o 	 Image tile: this setting defines how repeating images are handled.
  Automatic: Automatically select the most appropriate mode (this is the default).
  Repeat image: Repeat the image by tiling it.
  Clamp image: Clamp the image at the edges.

o 	Normal map: The selected image is treated as a XYZ normal map rather than as a height map (only 
available on embossing layer images).

o 	Logarithmic scale: Increase precision on embossing masks by using a logarithmic scale.

o 	Cut out label stencil: Enabling this option will add a transparent border around the image. This is useful 
if the image is a label. The border makes it easy to freely position the label on a product without affecting 
the other materials.

o 	Flip embossing in/out: Flips the direction of embossing masks. A positive displacement becomes 
negative, and vice-versa.

11.6.1  Loading a new image
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Materials can be independently stored by adding them to the material preset list. Material presets are automatically available from any environment 
and can be applied to models with a simple mouse click. Presets can store complete materials with all surface properties, duplicating the full original 
material. They can also store partial materials, only affecting specific layers or individual material settings.

o 	Default materials: Default materials contain a collection of generic standard materials.
o 	User materials: User materials contain your own custom presets.

o Create new preset: add a new preset using the material currently selected in the material editor (see 
chapter 11.7.1).

o 	Remove current present: permanently delete the selected preset or folder.
o 	Add folder: add a new empty folder to the custom material collection.
o Activate current preset: press this button to replace the material selected in the material editor by a preset.

Figure 11-11

Various commonly used standard materials already come with Store Visualizer. You can also add your own custom materials to the preset list.

Figure 11-12

When creating a new preset, you will have to define what parts of the current material are to be stored. By default everything is stored, and the preset 
represents a perfect replica of the original material. Some presets might only modify parts of an existing material. For example, a varnish will modify 
the reflectivity and glossiness of a material, but not its color or transparency. In such cases, you may freely choose the parts of the material that will 
be affected when the preset is activated.

o Preset name: Enter a name for your new preset in the top entry field.

o 	Apply preset to: Select the settings and layer maps the preset applies to. By default, the new preset will apply to 
everything.

o 	Press Create to create the new preset.

You cannot create or modify the presets in the “Default material” branch. Before creating a new 
material preset, make sure that either the “User materials” item or one of your own custom folders 
is selected.

11.7.1  Create new preset

11.7  Material presets

• Click on the “Open material presets” icon (Fig. 11-01) to open the window “Material presets”. Fig. 11-11 will appear. 
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Figure 12-01

• On the sidebar, select the Tools tab, and open the “Library” panel (see chapter 6.1).

•	Select where you want to create the 3D model. This can be in the project library, an external library or a folder within the external library. You 
can also select an already-existing model. The new model will be added to the same library as the model selected. 

• Click the “Create a new model or resource” icon (Fig. 12-01). A drop-down menu opens (Fig. 12-02).

Store Visualizer offers several functions that allow you to automatically generate several types of 3D model without the need for a CAD program. The 
3D models will be created based on the parameters and options that you have configured and will appear in your library to be used like any other 
model in Store Visualizer.

• In the drop-down menu, select “Create a shelf frame”. The “Create a shelf frame” window opens (Fig. 12-03).

Figure 12-02

The generated shelf frames are configured and do not require any further adjustment. The materials of the generated shelf frames 
can be adjusted in the same way as those of an imported model (see chapter 11). 

• Configure the shelf frame according to your requirements (see next page) and confirm your choice by clicking OK. Cancel will abort the shelf 
frame creation operation.

•	 The “Generating models” window will appear while the shelf frame is being created. Once the 3D model has been generated, it will appear in 
the “Libraries” panel in the selected location and can be viewed using the “Model browser” (see chapter 6.6).

Chapter 12 : Create a new model or resource

12.1  Create a shelf frame
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Figure 12-03

o 	 Presets: contains a list of standard EU and US shelf frame dimensions. Double-click the selected 
entry to automatically fill in the related input fields. You will then be able to modify the settings for the 
selected preset shelf frame if necessary.

o 	 Back panel: lists the options for the shelf frame back panel..
  Width: the width of the shelf frame back panel.
  Height: the height of the shelf frame.
  Type: drop-down menu proposing different types of back panels (single backpanel, standard 

panels or large panels).

o 	 Uprights: defines the dimensions of the uprights positioned on the left and right of the shelf frame.
  Width: the width of the uprights.
  Depth: the depth of the uprights.

	 Upright hole metrics: contains the dimensions of the upright hole.
  Width: the width of the upright hole.
  Height: the height of the upright hole.
  Spacing: the vertical spacing between two upright holes.
  Type: offers two types of uprights (single, double).

o 	 Base deck: defines the dimensions and options concerning the base deck of the frame.
  Frame has a base: click if you wish to add a base to the shelf frame.
  Depth: the depth of the base.
  Depth: the depth of the base.

  Brackets: opens a drop-down menu proposing various types of brackets to support the base 
panel.

  Price tag: opens a drop-down menu proposing several types of price tag. 
  Front over: panel overhanging the front of the base.
  Add kick plate: click if you wish to add a kick plate to the base.

You can create numerous types of 3D shelf frames using the “Create a shelf frame” function. A list of shelf frame presets supplied with the software 
allows you to quickly generate a 3D shelf frame model based on standard EU and US dimensions.
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Figure 12-04

• On the sidebar, select the Tools tab, and open the “Library” panel (see chapter 6.1).

•	Select where you want to create the 3D model. This can be in the project library, an external library or a folder within the external library. You 
can also select an already-existing model. The new model will be added to the same library as the model selected. 

• Click the “Create a new model or resource” icon (Fig. 12-04). A drop-down menu opens (Fig. 12-05).

• In the drop-down menu, select “Create a shelf panel”. The “Create a shelf panel” window opens (Fig. 12-06).

Figure 12-05

The generated shelf panels are configured and do not require further adjustment. The materials of the generated shelf panels can 
be adjusted in the same way as those of an imported model (see chapter 11). 

• Configure the shelf frame according to your requirements (see next page) and confirm your choice by clicking OK. Cancel will abort the shelf 
frame creation operation.

•	 The “Generating models” window will appear while the shelf frame is being created. Once the 3D model has been generated, it will appear in 
the “Libraries” panel in the selected location and can be viewed using the “Model browser” (see chapter 6.6).

12.2  Create a shelf panel
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Figure 12-06

o 	 Presets: contains a list of standard EU and US shelf panel dimensions. Double-click the selected 
entry to automatically fill in the related input fields. You will then be able to modify the settings for the 
selected preset shelf panel if necessary.

o 	 Options
  Width: the width of the panel.
  Depth: the depth of the panel.
  Brackets: opens a drop-down menu proposing various types of brackets to support the panel.
  Price tag: opens a drop-down menu proposing several types of price tags.

You can create numerous types of 3D shelf panels using the “Create a shelf panel” function. A list of shelf frame presets supplied with the software 
allows you to quickly generate a 3D shelf frame model based on standard EU and US dimensions.
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13.1  Tonemapping settings

• Click on the “Tonemapping settings” icon.
• The “Tonemapping system” dialog appears (Fig. 13-02).

Store Visualizer uses a high dynamic range rendering system (HDR). It is capable of simulating a much higher dynamic range of light than a typical 
computer screen or projector can display. In order to accommodate this, Store Visualizer uses an exposure system, much like a real camera does. 
Changing the exposure and tone mapping settings will adjust the way bright lights and high contrast areas are rendered. It will also define how colors 
are reproduced.

Figure 13-02

o  Exposure: Controls the overall brightness of the visualization.

o  Contrast: Increases or decreases the image contrast.

o Tone mapping equation: Controls how light and colors are mapped to low dynamic range 
(Logarithmic exposure is generally used).

Chapter 13 : Environment panel

• Select the environment toolbar by clicking on the “Environment” icon (Fig. 1-01) located on the bottom panel bar.
• The environment toolbar appears (Fig. 13-01), and is now active.

• Exposure Panel: The exposure tab controls the way high dynamic range lights are rendered on a low 
dynamic range computer screen or projector.

Figure 13-01
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o  Enable glare: Check to enable the glare / bloom effect.

o  Intensity: Controls the strength of the effect.

o  Diffusion: Controls the size of the light beam around the light sources.

• Glare Panel: The glare settings can be used to add a glare or bloom effect around very bright light 
sources. This can often increase realism, as it simulates light intensities that cannot be reproduced on a 
normal computer screen or projector.

o  Color ambiance: a drop-down list offers a selection of color ambiances that apply to the brightness 
effect, changing its color.

o  Extra bright glare: Allows the effects of brightness / the bloom effect to be accentuated more.

Figure 13-03

13.2  Stereo and multi-display control

• Click on the “Stereo and multi-display control” icon to enable or disable stereoscopic rendering.

Depending on the configuration of your hardware, stereoscopic rendering mode can be adjusted via: Preferences > 
Extensions > Stereoscopic rendering > Stereoscopic rendering control (Chapter 24.5).

Store Visualizer can work with compatible stereo displays and projection systems. Contact your reseller to obtain further information about the Store 
Visualizer stereoscopic rendering module.
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• Click the “Edit reflection spheres and zones” icon to reveal or hide the gizmos (Fig. 13-04) representing the reflection points in your 
store. When creating a project, a default reflection point is placed in the centre of the scene. Use the object selection and manipulation 
tools (see chapter 6) to select and move this reflection point through the 3D virtual store. The environment visible in the reflection of the 
objects will depend on the position you will have chosen. If the reflection of the environment in the 3D models is not acceptable, move 
the point. The environment shown in reflective objects will change according to the position you chose. Repeat the process until you 
are satisfied with the results.

In a virtual 3D store, the environment seen in all reflective objects is gathered from a point called the reflection point. You can create and move the 
reflection points in the most suitable zones depending on the layout of your store. Placing the reflection point at the center of an important aisle is a 
common approach.

Be careful not to place the reflection point inside an object or a shelf, behind a wall or below the floor. This would result in 
abnormal or missing reflections !

• For performance reasons, the reflections you see in objects will not adapt to large changes of your store in realtime. Click on the 
“Refresh reflections” button to synchronize the reflections if you made significant modifications in your store. Note that reflections are 
automatically refreshed when a project is opened.

13.3.1  Default reflection point

• Select the Environment toolbar by clicking on the “Environment” icon (Fig. 1-01) located on the bottom panel bar.
• The Environment toolbar appears and is now active.

Figure 13-04

13.3  Reflection points and zones



Store Visualizer 18	 117

• Click the “Open reflection zone settings” icon to open the reflection zone control window (Fig. 13-05). A list showing the reflection 
points appears. The default reflection point appears at the top of the list. 

13.3.2  Setting several reflection points
To improve the realism in the reflective parts of the objects positioned in your 3D virtual store, you can create and set several reflection points. Each 
new reflection point will be assigned to a reflection zone. The reflection of the environment visible in the reflective parts of the objects will depend on 
the position of the reflection point and will only affect objects positioned in the reflection zone assigned to it. You can, for example, create a zone for 
each aisle. 

• Click the “Add new entry” icon to add a new reflection zone. A blue selection pointer appears (Fig. 6-19). Select a starting point by 
pressing the left mouse button. While keeping it pressed, move the mouse in the desired direction to reveal a blue outline. This outline 
defines the new reflection zone in which the new reflection point will be active. All the reflective parts of objects positioned in this new 
zone will reflect the environment surrounding the new reflection point.

Figure 13-05

Move the mouse until you are satisfied with the size of the zone. Release the left button of your mouse to complete the creation. The 
surface of the zone will be represented by a red rectangle (Fig. 13-06). You can access and modify the properties of each zone as well 
as the reflection points using the dialog “Reflection zone settings” (Fig. 13-05).

Figure 13-06

Figure 13-07

Use the object selection and manipulation tools (see chapter 6) to select and move a point or a reflection zone. At its edges, the 
reflection zone has gizmos in the shape of red squares. Click these squares to adjust the shape of the zone (Fig. 13-07).

We recommend that you create and manipulate the reflection points and zones using the “Layout view” mode (see chapter 
8.8).
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• Resolution: this setting lets you choose the resolution used to calculate the reflections of a point. The greater the resolution of 
the reflection point, the higher the quality of the reflection. A greater reflection resolution will increase memory consumption. The 
consumption of the graphic memory used by the reflection is indicated at the bottom of the “Reflection zone settings” window (Fig. 
13-05).

The default resolution is determined in the Preferences > 3D settings > Effects > Object reflections > Resolution.

• Click the “Remove entry” icon to clear the reflection zone and its point. The default reflection point cannot be deleted.

The reflective parts of objects not in a specific reflection zone will reflect the environment of the default reflection point.

• Refract: activate the “Refract” function when you have refractive objects in the area to increase the rendering quality of refraction.

Figure 13-08
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13.4  Adjust static elements

• Click the “Adjust static elements” icon.
• The “Adjust static elements” window appears (Fig. 13-09).

A Virtual 3D environment is made up of several static elements that can be modified in real time. The adjustable static elements of the templates 
supplied with the software are generally the floor and the walls.

13.4.1  Material presets

Figure 13-09

• Select the adjustable static element that you want to modify. In the example to the left, 
the Floor is selected.

We can make other static elements appear, according to your requirements, in custom virtual 3D environments.

A list of material presets supplied with the software enables you to quickly apply a new material to an adjustable static element. This list includes a 
selection of typical floor and wall materials. 

• In the Presets section, select one of the available Floor Materials. An image enables 
you to identify the material more easily. 

	
	 Double-click the selected material to apply it to the static element. If you are not happy, 

you can select another material and repeat the operation. 

When you select a static element in the list, it will be briefly highlighted in 
the scene so that it can be identified more easily.
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13.4.2  Adjust the static materials

Figure 13-10

The parameters of any preset material applied to a static element can also 
be adjusted.

o 	 Brightness: Enables the brightness of the material to be increased or 
decreased.

o 	 Reflectivity: Controls the reflectivity of the surface of the material. Drag 
the cursor to the left to reduce the reflectivity of the surface or to the right to 
increase the reflectivity.

o 	 Glossiness: Modifies the glossiness of the reflection of the material. Drag 
the cursor to the left to reduce the glossiness of the surface or to the right to 
increase the glossiness.

o 	 Move: Reposition the layer by moving it horizontally or vertically.

o 	 Resize: Modify the horizontal or vertical dimensions of the layer.

• Adjust: This section enables certain parameters of the static element selected from the 
list of editable materials to be modified.
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13.4.3  Modify static images

Figure 13-11

o 	 Color image: Enables the color layer to be activated or deactivated on the 
surface of the static element. If the color image is deactivated, you will be able 
to apply a color to the static surface, see Fig. 13-12.

	
	 Click the “Pick color” button to select a color for the static surface. 

o 	 Reflective image: Enables a reflection layer to be activated or deactivated on 
the surface of the static element.

o 	 Bump image: Enables a bump layer to be activated or deactivated on the 
surface of the static element. 

o 	 Bump strength: Scale that controls the bump depth. You can simulate both a 
positive and negative bump. A negative scale value will reverse the direction of 
the bump.

o 	 Lock layers: Locks the positioning and dimension parameters of the reflection 
and bump layers to the values of the color layer.

• Images: This section enables the images present in the previously selected static 
element to be modified.

o 	Show color/reflective/bump image: This icon will open the “Texture viewer” 
window and display the image currently assigned to the respective layer.

o 	Load a color/reflective/bump image: This icon enables you to load a custom 
image from your hard disk onto the respective layer.

Figure 13-12
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• On the sidebar, select the Scene tab, and open the “Model meta data” panel (Fig. 14-01).

Store Visualizer gives you the option of adding meta data to the 3D models and displaying it in real-time. The meta data can be input manually or 
imported from a database or a planogram file.

Figure 14-01

•	Select one or more 3D models to access their meta data. You can also select one or more folders or a library to access the meta data of the 
models that they contain.

By default, the models imported into the software do not display meta data.

• On the sidebar, select the Tools tab, and open the “Library” panel (see chapter 6.1).

o 	Add new fields: Opens the “Add meta data” window (Fig. 14-02) which enables new tags as well as their 
initial value to be added.

o 	 Import meta data: Enables *.CSV files to be imported from a database containing meta data.

o 	Remove selected fields: Deletes the selected tags as well as their values.

o 	Show product meta data: Displays the meta data of the 3D objects selected in the scene in a floating 
window (see chapter 14.4)

o 	Field name: Shows a list of all tags used by the selected 3D models.

o 	Value: Shows a list of values associated with the tags.

The model meta data is displayed in two columns, a field name and its value. The field, also called a metatag, describes the type of information 
represented by the meta data (e.g. manufacturer, price, product color, etc.) The value encodes the content of the meta data for each model.

Chapter 14 : Management of model meta data
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• In the “Model meta data” drop-down menu, click the “Add new fields” icon (Fig. 14-01). The “Add meta data” window opens (Fig. 14-02).

Figure 14-02

• Click the “Add new entry” icon. A drop-down menu appears in the Field name section (Fig. 14-03) and in the Value section (Fig. 14-04).

Figure 14-03
Figure 14-04

• Select the entry that you wish to add to the model in the drop-down menu (Fig. 14-03). The list contains a selection of tags commonly used in 
the packaging and retail sector. 

• Repeat the process if you wish to add several tags. 

o 	Leave empty: The value of the tag will be empty. You can then modify it manually or by importing from a database.

o 	Model name: The value of the tag will match the name of the 3D model. 

• Select in the Value drop-down list (Fig. 14-04) the initial value relating to the tag.

o 	Model description: The value of the tag will match the description of the model. 

o 	Custom value: Double-click in the value column in order to insert the desired initial value for the tag. 

If your 3D model contains the UPC/EAN number in the “Model description” entry field (Chapter 6.7), it is possible to automatically 
retrieve it and display it in the value of the UPC/EAN tag. In the Value drop-down list, select the Model name or Model description 
option to retrieve the UPC/EAN number and have it automatically displayed in the UPC/EAN tag.

14.1  Add a new metatag
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• Double-click in the Value column, across from the Field name (tag), to modify the value manually (Fig. 14-05).

Figure 14-05

• In the “Model meta data” panel, click the “Import meta data” icon (Fig. 14-01). The “Load database file” window opens. 

• Select the database file that you wish to import.

• Confirm your selection by clicking Open. Cancel will abort the import operation.

Store Visualizer imports *.CSV files.

• The “CSV table import” window (Fig. 14-06) will appear. This enables you to choose how the CSV fields will be assigned to the metadata fields.

The Values contained in the CSV file will replace all the Values of tags already present. 

14.2  Manually modify the values of metatags

14.3  Import meta data
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Figure 14-06

o 	Encoding: Enables the type of encoding used when creating the CSV file to be selected 
to correctly display the information from the imported file. 

o 	Separator: Enables the type of separator used when creating the CSV file to be 
selected. 

o 	Row selector: Enables the header line of the CSV file containing the field names to be 
selected.

o 	CSV field: Shows a list of column headers in the CSV file.

o 	Meta field: Drop-down list showing the metadata fields (metatags) available in Store 
Visualizer.

The “CSV table import” window allows you to configure how the CSV file will be linked to the 3D models selected in your library, as well as choose 
the assignment between the fields available in your CSV file and the metadata fields (metatags) in Store Visualizer.

o 	Match with: Drop-down list containing the various ways of linking the lines in the CSV 
file with the 3D models (Fig. 14-08).

• Use the “Meta field” drop-down list (Fig. 14-07) to assign a corresponding meta field (metatag) to the CSV field. If you do not want to assign a 
tag, select the option None.

Figure 14-07
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Figure 14-08

• Use the “Match with” drop-down list (Fig. 14-08) to define how each line in the CSV file is linked to the corresponding 3D model, selected in 
your library.

In the example (Fig. 14-08), the CSV file has a “Name” field which lists the 
names of the 3D models. It is therefore via the name of the 3D model that we will 
be able to link the CSV file to the 3D models present in the library.

• Import your file by clicking OK. Cancel will abort the import operation.

• Once importing is finished, the “Info” window appears and informs you whether the CSV has been properly loaded and the number of 3D 
models to which the metadata has been assigned.

Figure 14-09

• Select a 3D model in your library to which you have assigned metadata. These will appear in your “Model meta data” panel (Fig.14-09).

In certain complex cases where there is no direct equivalence between the 
name displayed in the CSV and in the 3D model, Regex filters can be used to 
customize the comparison (Advanced matching).
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• On the sidebar, select the Scene tab, and open the “Model meta data” panel (Fig. 14-01).
• Click the “Show product meta data” icon to activate the display function. When you select a 3D object in the scene, a floating window 

will appear displaying the metadata for the product (Fig. 14-10). Unclick the “Show product meta data” icon to deactivate the display 
function.

Figure 14-10

14.4  Display product meta data
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Chapter 15 :  Management of dynamic lights

Importing a 3D file containing light sources is done in the same way as importing a standard 3D file (see chapter 6.2). In the “Import 3D file” window, 
select the Lighting section (Fig. 15-01). This section enables you to configure the 3D models that contain the dynamic lights.

15.1  Import a model with one or more light sources

A project can contain two types of lights: static lights, which includes all light sources that were pre-calculated when creating the 3D scene (see 
chapter 13.1), and dynamic lights, which encompass the 3D models containing one or more light sources that have been imported into a project. 
Only dynamic lights can be positioned and moved in real time in the project.

o 	Detail level: Controls the resolution of the energy field created by the light source. By increasing the 
detail level, you will increase the quality, but will consume more memory.

o 	Lighting quality: Controls the accuracy of the calculation of the light. The higher the quality, the 
more time needed for the calculation, without impacting the amount of memory used.

o 	Light range: Controls the maximum range of the light on the environment.

o 	Adaptive shape: Represents the direction/diffusion of the light beam in the environment according to 
the contours of the source. A highly focused source, such as a spot light, presents a higher adaptive 
shape than an omnidirectional source, such as a bare bulb.

o 	Close bottom: If checked, the energy field will be cut off below the floor in order to not waste 
memory. This function is useful for all 3D models placed on the floor.

o 	Light type presets: Opens a dropdown list (Fig. 15-02) containing common light source types. 
Selecting a light type will automatically modify the lighting parameters. If you used a preset type, you 
still have the option of subsequently adjusting the lighting import parameters.

Check “Import dynamic lights” in order to activate the processing of the lighting during import.

Figure 15-01

Figure 15-02

o 	Close top: If checked, the energy field will be cut off above the source in order to avoid light artefacts 
from lights placed on thin surfaces (e.g. a line of LEDs positioned on the bottom of a shelf).
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15.2  Modify the model lighting

• Click the “Display model with light range” icon (Fig. 15-03) to show a red gizmo representing the light range for 
the 3D model. Click the icon again to hide the light range.

Figure 15-05

• In the sidebar, select the Tools section and open the “Model lighting” panel (Fig. 15-04).

Figure 15-03

o 	Luminous flux: Controls the quantity of light emitted per unit time, in lumens (lm). For example, a 75 W 
halogen lamp is equivalent to around 1190 lm.

o 	Temperature: Controls the color temperature of the light source in Kelvin.

o 	Light type presets: Opens a dropdown list (Fig. 15-05) containing common types of light sources. 
Selecting a source type will automatically adjust the color temperature.

• Select a 3D model containing a light source from a library. The lighting parameters of the model will be shown in 
the “Model lighting” panel.

o 	Light sources: The top part of the panel shows a list of independant light sources present in the 3D model. 
Click an entry to select the source that you want to modify. Double-click an entry to modify the name of the 
source.

Figure 15-04
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15.3  How to create a 3D model with lighting using CAD software
In order for Store Visualizer to be able to recognize, during import, that your 3D model contains one or more light sources, you have to use a certain 
method when modelling the 3D model with CAD software.

Currently, if you import a 3D model containing several light sources, all the sources will be combined into a single light source to 
avoid excessive memory consumption and overly long calculation times when importing.

• In the CAD software, select the mesh or object that will produce the light (bulb, neon tube, etc.).

• Add the term Lightsource at the beginning of the mesh or object name. For example, the name could be Lightsource neon 1. All meshes 
or objects for which the name begins with Lightsource are identified as light sources by Store Visualizer.

• You can also specify the luminous flux by indicating the number of lumen (lm) after the term Lightsource in the name. To do this, you 
have to leave a space or underscore _ between Lightsource and the number of lumen followed by lm. For example, Lightsource 25lm 
or Lightsource_25lm. If you do not specify the luminous flux in the name, a default value will be used. You can always modify the value of 
the luminous flux in real time after importing the 3D model into Store Visualizer.

• Export the 3D model in a format that is compatible with Store Visualizer.

• Import the 3D file into Store Visualizer (see chapter 15.1). After importing, the 3D model will appear in the library and you will be able to 
adjust the lighting parameters (Fig. 15-06).

Figure 15-06
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Chapter 16 :  Physics

• Select the physics toolbar by clicking on the “Physics” icon (Fig. 1-01) located on the bottom panel bar.
• The physics toolbar appears (Fig. 16-01), and is now active.

• The Play/Stop button controls the current status of the simulation. Press “Play” to start running the simulation, and “Stop” to interrupt 
it. Once the simulation is running, all objects placed within the environment will be subject to physical laws. They will collide with other 
objects and will be affected by gravity and other external forces. Objects that were placed in an unstable position will slide, roll or fall.

16.1  Simulation control

Store Visualizer comes with a physical simulation module which allows you to simulate collisions and the application of physical forces onto your 
products. Amongst others, it can be used to interactively visualize shelf placement constraints or gravity feed shelving systems. Depending on the 
complexity of the projects, you will assign the physical simulation to the entire scene or to a selection of products.

Figure 16-01

When a project is opened, all the objects in it will be affected by the physical simulation. This is indicated by the message “Physics will affect the 
entire scene”. If you are working on a project with a very large number of products or your computer is not very powerful, you can assign the physical 
simulation to a specific part of the scene (see chapter 16.1.2).

16.1.1  Simulating physics on the entire scene

• When the physical simulation is running on part of the scene (see next chapter) and you want the entire scene to be affected, click the 
“Simulate the entire scene” icon. The current physical simulation process will stop automatically. Press the “Start” icon again to start 
the simulation.

By default, the physical simulation will always affect the entire scene.



132										                                  	            Store Visualizer 18

16.1.2 Simulating physics on part of the scene

• Step 1: Select the 3D objects to which you wish to apply the physical simulation. Then click the “Simulate all currently selected 
objects” icon. The message “Physics will affect parts of the scene” appears.

• Step 2: Press the “Start” icon to activate the simulation. The message “Physics is running on parts of the scene” appears. All 
products selected in step 1 will be affected by the physics. Press the “Stop” icon to interrupt the simulation.

You can assign the physical simulation to a specific part of the scene such as a display space, a shelf, a rack, a tray, a POS or similar (partial 
simulation). This can be desirable for the reasons mentioned in chapter 16.1.

To assign the physical simulation to all the products present on a shelf, on a rack or in a display space, you must first change 
construction mode (see chapter 8) to select the shelf, rack or display space to which you want to assign the simulation. Once you have 
selected it, click the “Simulate all currently selected objects” icon. Return to product mode (F2) to proceed to step 2.

A 3D object affected by a partial physical simulation will pass through all the other objects not affected by the partial 
simulation, except shelving, which will always be affected automatically.

All 3D objects created while the physical simulation is running on part of the scene will automatically be affected by the 
physics.

16.2  Put scene to sleep

• In certain situations some objects may become unstable and jitter or shake slightly. In order to stabilize such objects, select them and 
press the “Put scene to sleep” button.

A lot of physical instability issues are due to problems in the geometry of imported 3D models. Please use your CAD modeling 
application to make sure that your imported models have clean geometry and a planar base. The “Show collision envelope” 
tool in the Store Visualizer model browser can help you to identify such problems.
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16.3  Simulation time scale

• The Toggle between physics or conventional move button selects how collisions between the object and the environment are handled.

16.4.1  Toggle between physics or conventional move

You can interact (move/rotate) with objects under physical simulation the same way you learned in chapter 6. However when a simulation is running, 
a number of physical restrictions apply. You may not push an object through a shelf panel or another object, for example.

While you are moving or rotating an object, certain physical laws are temporarily disabled. This makes it easier to manipulate the object. Once you 
stop interacting with it, by releasing the left mouse button, all physical laws come back into effect. For example, you might move a product out of a 
shelf, holding it floating in the air. Once you release the mouse button, gravity will make it fall down.

16.4  Moving objects with the physics module

The time scale slider controls the speed at which the simulation runs. By default, the simulation will run in realtime, corresponding 
to a scale of 1x. Dragging the slider to right will increase the speed of the simulation, creating a time lapse effect. Dragging it to 
the left will put the simulation into slow motion, allowing you to observe physical effects that would otherwise be too fast to see.

The object move, rotate or scale mode must be active in order to interact with objects. See chapter 6 for more information.

o If the icon is clicked, the displacement force of the object is reduced and proportional to its mass. The object collides with the 
other objects in its environment without unduly affecting them. This is the mode used by default.

o If the icon is not clicked, the displacement force of the object is very significant, ensuring its accurate movement. The objects 
located in the environment will be affected by it, giving priority to the moving object.
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• Dragging is an alternative mode of moving an object. It is only available while a physical simulation is running. It works by grabbing the 
object at a point, and pulling it as if it was attached to a rubber band. Dragging is a very flexible mode of interaction, and it is the most 
physically correct. All physical properties are taken into account while dragging, including mass, momentum and friction.

•  Enable dragging mode by pressing the “Drag object” icon. Now click on the object you would like to move at the point you would like 
to attach the virtual rubber band. Hold the left mouse button and move the object.

• If you press the Ctrl key while still holding the left mouse button, you may move the object up and down. Without the Ctrl key pressed, 
your movements will be on a horizontal plane.

Drag object + CTRLDrag object

16.4.2  Drag object
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16.5  Physical properties

• On the sidebar, select the Tools tab, and open the “Model physics” panel. Fig. 16-02 will appear.

The predefined material list contains a selection of commonly used generic material types. Click on an entry to 
assign a surface material to your model. Materials can be customized using the bounciness and friction spinners 
described below.

o 	Enable physics: Enable or disable physical simulation on objects created from the selected model.

Figure 16-02

In order to react realistically, the simulator needs to know about a number of physical properties, such as the models weight and surface.

Changing the surface material will only affect the way a model reacts in the physical simulation. It will not 
change its visual aspect.

o 	Bounciness: The bounciness or elasticity defines how easily an object bounces away on a collision. 0% will result 
in objects that do not bounce at all, while 100% will yield highly elastic objects.

o 	Material properties: Use the Material properties section to assign a certain surface material to your model. The 
surface type will change the way objects react when they are in contact with other surfaces or objects. A rough 
surface material such as cardboard is less likely to slide (it has higher friction) than a smooth plastic surface, for 
example.

o 	Mass: Defines the mass of the model in the weight unit active for the current project. Heavier objects will have 
more momentum when they collide with other objects, and they will require a larger force in order to be moved. The 
default mass is 1kg (2,2lb).

o  Collision accuracy: See chapter 16.6 for details of the collision envelope parameters.

o 	Lock object position: Objects created from models with this option enabled will be glued to their position in 
the environment. They can still be moved by the user, but not by external forces such as those generated from 
collisions or by gravity. 

o 	Friction (CoF): Friction defines how fast a slipping object slows down. The higher this value, the more friction the 
object experiences while sliding over a surface and the quicker it will come to a halt.
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16.6  Collision accuracy
The physics simulator typically uses an approximate shape representing the object so to increase the performance of the simulation. The collision 
accuracy section allows you to control the precision of this shape. The default accuracy, global envelope, is appropriate for most packaging models 
or consumer products. If however your model contains large cavities in which other objects are placed into (for example a tray or a display), then the 
default mode is not appropriate anymore. The shape would cover the cavities and you would not be able to place any objects into them. For such 
models, select the decomposed envelopes mode or the planar envelopes mode.

You can easily view the shapes generated by the physics simulator by using the two envelope viewer buttons in the model browser panel:

o Press the “Show model with collision envelope” button to display the model together with its physics envelope. Click the button 
again to hide the envelope.

Global box Global envelope

16.6.1  Viewing collision shapes

o Press “Show collision envelope” to display the physics envelope alone, without showing the original 3D model.

Global envelope

When an object is frozen in the scene, it will automatically have a highly accurate collision envelope.
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16.6.2  Collision envelope - Global box

• Global box: this mode approximates the objects’ shape with a box. This is a very high 
performance mode, and is ideally suited for models that have an inherently box-like 
shape. If applied to models that are not box-shaped, this mode may generate visual 
errors in the physical simulation.

When a 3D model is imported, the physical module automatically detects 
whether it can have a box-type envelope. The global box collision envelope 
is automatically selected. You still have the option of choosing another type 
of envelope at any time.

The accuracy of collisions between the 3D models will depend on the collision envelope that you have allocated to each of your models. The physical 
simulation model offers you four types of collision envelope. You have to select the collision envelope suitable for the physical simulation to run 
optimally. 
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16.6.3  Collision envelope - Global envelope

The global envelope mode is applied by default to new imported models with 
the exception of models that can have a box-type envelope (see previous 
chapter).

• Global envelope: this mode fits a convex skin around the model, following its outline 
as close as possible. The global envelope mode achieves both good performance and 
fits models with arbitrary shapes. 

	 As such, it is a good default choice for most non-box shaped products. This mode 
cannot be used with hollow models containing other objects (such as trays, hollow 
boxes or displays, for example). The envelope will cover the cavity and you will not be 
able to place objects inside it.
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When you select the decomposed envelopes mode or you modify the quality or the cavities, the system will have to prepare the new 
envelope. This operation is performed only once and the result of the calculation is saved in the library.

16.6.4  Collision envelope - Decomposed envelopes

o	 Quality: quality of the decomposed envelope.

Decomposed envelopes require high performance and may therefore significantly slow 
down the physical simulation if there are too many of them. We advise you to only 
activate this type of envelope if the envelopes above do not generate the required quality.

• Decomposed envelopes: this mode can fit a model very closely by using a combination 
of multiple convex envelopes and thus allows a very precise simulation. It should be 
used for models featuring large cavities.

o	 Concavities: Detail level for the decomposition of cavities.

Global envelope

In the example below, the object presents a global envelope versus a decomposed 
envelope. The global collision envelope is less accurate and the contours of the model 
are less well cut out but the simulation speed will be faster.

Decomposed envelope - Coarse
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16.6.5  Collision envelope - Planar envelopes

o	 Quality: Quality of the planar envelope. The further you drag the slider to the 
right, the higher the quality of the planar decomposition will be. In the example on 
the left, you can thus increase the rounded cut of the cardboard box.

• Planar envelopes are used in models consisting of hollows or individual planar 
elements, such as cardboard panels or metal sheets. Planar mode was specifically 
designed for use with trays, displays and similar models.

o	 Holes: Minimal area of holes to be decomposed. The further you drag the slider 
to the right, the more you decompose the holes present in your model. In example 
16-03, the holes on the bottom of the tray will appear with a higher decomposition 
of the holes.

Fig 16-03

Planar mode does not work with models not made of distinct planar elements. In this 
case, the decomposed envelopes settings should be used instead.
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Chapter 17 : Product viewer
The product viewer mode allows you to inspect the details of a product from all sides.

o  Reset orientation: Puts the object back into its original orientation it had on the shelf.
o  Center camera onto product: Center the product in the middle of the screen.
o  Change rotation pivot point: Modifies the rotation center of the object.
o  Second rotation axis is X: Performs a rotation around the Y and X axes.
o  Second rotation axis is Z: Performs a rotation around the Y and Z axes.
o  Open array control: Allows modifications of an object array while in product view mode.
o  Exit product viewer: Quits the viewer mode and returns the product back to the shelf (or press “p”).

When in product viewer mode, a control window will appear (Fig. 17-01):

The product viewer can be used on single objects, groups or arrays.

Figure 17-01

• Select the object to inspect by using the selection mode (see chapter 6).
• To enable the product view mode, you may either :

o   Click on the “Product viewer” button, located on the right hand side of the object manipulation toolbar. 
o   Or simply press the “p” key on your keyboard.

• The selected object(s) will leave the shelf and move towards the center of the aisle. It can then be closely inspected from all sides.
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You may also configure the movement trajectory by directly clicking on the curve graph.

17.1  Product viewer settings

Figure 17-02

• Open the “More actions” menu located on the right hand side of the object manipulation toolbar.
• Select “Product viewer settings” or use the keyboard shortcut Shift+P. The settings dialog will appear (Fig. 17-02).
• You can now adjust the product viewer configuration for the current project.

o	 Viewer metrics: 

	 Distance: The distance the object will travel from its position on the shelf to the center of the aisle.

	 Height: The height the object will float at when in product viewer mode.

	 Move time: The time the object takes to move from the shelf to the aisle (in seconds).

	 Steepness: Changes the angle of the curve the object will take when travelling to the center.

o	 Camera follow: 

	 Enable camera follow: when clicked, the camera will automatically follow the object as it leaves or 
returns to the shelf.

	 Reaction speed: adjusts the camera follow speed.

o	 Automatic disabling: the product is automatically returned to its original position when the camera is 
moved a certain distance away from the product.

• Toggle view: enters or quits the product viewer mode (you may also press the “p” key)

• Movement axis (spherical photographic environments): The shelf to aisle movement can be performed on either the X axis, the Y axis 
or through automatic axis selection. It is recommended to let Store Visualizer choose the best axis automatically.
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18.1  Snapshot
A snapshot of the current view can be taken at any time and saved to disk as a standard image file. Supported formats include JPEG, PNG, TIFF and 
others. 

• Choose a viewpoint at the place you would like to take the screenshot.
• Right click on the rendering area to open the context menu.
• Select File > Snapshot
• Select the location and enter the file name you would like to save the snapshot under and specify the image format. Click on Save.
• A dialog with the snapshot settings will appear (Fig. 18-01).

o  Resolution: Choose the resolution of your snapshot image (screen size, x2, x4, x8, custom). 
o  Quality: Additional anti-aliasing can be applied for best possible quality of your snapshot.
o  Width/Height: The image resolution the snapshot will be taken at. You can manually modify the resolution 

by choosing the “custom” setting in the resolution dropdown.

Figure 18-01

• Click OK to take the snapshot.

Chapter 18 : Snapshot and print

• The “quickshot” feature will take additional snapshots using the previously selected settings. The file names will be numbered automatically.
• Open the contextual menu and select File > Quick snapshot ...

18.2  Quick snapshot
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18.3  Print

• Choose a viewpoint at the place you would like to take the screenshot.

• Right click on the rendering area to open the context menu.

• Select File > Print.

• Store Visualizer will use your configured PDF viewer application to print the image.
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Chapter 19 : Create a placement report
When working with the “Object array” feature, Store Visualizer can create a placement report from your arrays. Report functionality is usually provided 
by customized plugins. This chapter describes the generic report process.

Step 1: Report header

You may freely configure the font size, type and color of the company and product name 
entries, such as they will be included in the report PDF.

Step 2: Image

In order to find a perfect camera view for the screenshot, just use the standard 
navigation features as described in chapter 2 and 3.

• Company name: type the name of your customer.
• Product name: the report title, or the name of the products shown in the report.
• Click the “Load an image” button to add logo images to the report:

o  Enable vendor logo: Includes your own logo on the top right of the report (your logo 
image can be set through the report plugin Preferences > Plugins).

o  Enable customer logo: Includes the client logo at the top left of the report.

• Select the array you would like to create a report from.
• Open the “More actions” menu located on the right hand side of the object manipulation toolbar and select “Array settings”. You can also 

press Shift-F, as described in chapter 25.
• Click on “Settings”, and select “Generate report” to launch the “Report wizard”:

• Click on the “Photo” icon to insert a screenshot of you current 3D view into the report.

• A preview of the screenshot appears. If you are not satisfied with the result, simply repeat the 
process with a different camera view.

Figure 19-01
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• Select the product you would like to show in the “Model browser”.
• Choose a “Layout”.
• Click on the layout element where a product should be added to, which will be shown with a red 

border.

• Click on “Add model browser image” to add the current model browser view.

Step 3: Product overview

You can switch the layout at any time. The inserted product views will be adjusted automatically.

• Different layouts are useful if you would like to show multiple views of the product or more than one product at the same time. It can also be 
used to show close-ups of distinct product parts.

• 	Select the layout element where the product 
should be placed by clicking on it. A red border 
will validate your selection.

• Pressing the “Add model browser image” 
button will add the model and view angle 
currently shown in the model browser to the 
selected layout element.
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• Comments about the project can be added into this field. They will appear on the report PDF. 

• This check box will “Include the generation date into report”.

• Author name: The name of the author who created the report (optional).

Step 4: Comments

The font style, size and alignment of your comment can be configured freely.

Step 5: PDF export

• PDF options:
o   Interpolate images: Increases image quality when the report PDF is zoomed onto.  
o   Show report after export: Opens the generated report with PDF reader after export.
o   Image quality: Choose the quality of the images included in the PDF. Higher quality will 

produce larger PDF files.

• Print the report directly without saving it first.

• Export the report as a standard PDF file.
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Step 6: The final generated report

The following elements make up your report:

• Company name: Your customer’s name.

• Product name: The name of the product shown on the report.

• Vendor logo: Your logo image.

• Customer logo: The logo image of your client.

• Screenshot of your product in the 3D environment.

•	Array placement: Placement metrics and surface area used by your 
products on shelf. The data is taken from the array that was used to the 
generate report.

• Layout: Views or close-ups of your product.

• Comments related to the project.

• Date the report was created.
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Chapter 20 : Create a standalone viewer
Sometimes you might want to share your projects with colleagues or clients that do not have Store Visualizer installed on their computer. While you 
could take screenshots or generate a report as described above, it is often more effective to let them explore the project the same way that you 
designed it in Store Visualizer - interactively and in real time.

With only a few mouse clicks, you can use Store Visualizer to generate a viewer file from your project. This small executable file can easily be copied, 
sent by email or put onto a website. By simply double clicking it, your clients will be able to view a realtime 360° representation of your project at the 
point you selected. 

• Right click on the Store Visualizer render area to open the main contextual menu.

•  Select File > Export.

Figure 20-01

On the following screen, you will be able to add information about your project that your client will see when 
running the viewer. Note that all fields are optional, and you may leave them blank.

o  Title: Name of the view exporter.
o  Author: Author of the view exporter.
o  Comment: Comment your view exporter.

o  Compression : The exported viewer file is compressed, so to keep it small and easy to send over 
the internet. This compression can sometimes impact the visual quality of your project when the 
client views it. You can choose the amount of compression under compression quality. The higher 
the quality the larger the resulting viewer file will be.

 
o  Target system: Select the system the viewer should be able to run on (Windows or Mac OS).

o  Overlay image: Add an overlay image on your viewer to personalize your project.

•  Click on export to generate the view exporter.

•  Enter the name of the viewer file you would like to export. The file type depends on your clients computer 
system. Windows viewers are executable files (.exe), Mac OS viewers are compressed application 
bundles (*.zip). You can create Windows viewers even if you are running on a Mac and vice-versa.

•  Click on Save. The “Spherical view exporter” dialog appears (Fig. 20-01).
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The system will generate a viewer file at your selected location. It can be run by simply double clicking it. The viewer will work on almost all computers 
and it requires no additional software to be installed prior to its use.

•  A short “usage information” screen appears. If you need more detailed information on how to use 
the viewer, please click the online help button.

•  After a click on start navigation, you will be viewing your project in real time.

The project can not be modified in any way from within the viewer.
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Chapter 21 : Creating and editing a video

21.1  Creating a new sequence

Store Visualizer has a module for creating and editing videos in real time. With this tool, you can produce video sequences for real-time presentations 
or create video files.

• Click the “Toggle movie timeline visibility” icon to display the video editor above your toolbar.

• Click the “Create a new sequence” icon to create the starting point of your new video sequence. Store Visualizer will automatically 
create an initial camera event and an initial scene event. These appear on the timeline (Fig.21-01) and are symbolised by a green 
(camera event) and blue (scene event) semi-circle. These are the starting points of your video.

Figure 21-01

A sequence is a continuation of events arranged on a timeline. Different types of events affect the path of the camera, the movement of objects or the 
control of the physics. The first step is to create a new sequence, to which you will then add the events. All the sequences you create will be stored 
in your project.

• The first camera event represents the current position of the real-time camera, i.e. the image currently visible in real time of your project. 
The position of the camera of the first camera event (see chapter 21.2.3) can be adjusted at a later stage.

• The first scene event represents all the 3D objects positioned in the scene when the sequence was created. For more information on 
scene events, please see chapter 21.4.1.

• Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
• The navigation toolbar appears, and is now active.
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• Click the “Remove current sequence” icon if you want to delete the active sequence.

• The dropdown list of sequences (Fig. 21-02) lets you select the sequence that is currently active on the 
timeline. A project can contain multiple sequences.

Figure 21-02

21.1.1  Opening an existing sequence

• The input field also lets you rename your sequences.

21.1.2  Deleting an existing sequence

21.1.3  Activate or deactivate a track

Each track on the timeline can be individually activated or deactivated. The events present on a deactivated track will not be included in the reading 
or exporting of the sequence. Click on the respective icon to toggle the activation status of a track. All tracks are active by default.
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21.2  Creating a camera event

21.2.1  Adding a new camera event

A camera event is a camera point of view created from the position of the current view in real time. It appears on the track of camera events on the 
timeline and is represented by a green marker with an icon symbolising a camera. The continuity of camera events will define the path and speed of 
movement of the camera during the sequence.

Figure 21-03

• Use the classic navigation functions to move your camera to the point of view you want to add to the sequence. 

• Then click the “Add new camera event” icon situated at the front of the camera events track (Fig. 21-03). A new event corresponding 
to the current camera position will be added to the track (Fig. 21-04). 

Figure 21-04

• You can add a camera event at any point on the timeline. Click and move the cursor along the timeline (Fig. 21-05) to define the 
insertion point of the next camera event created by the “Add new camera event” function (Fig. 21-06).

Figure 21-05 Figure 21-06

Empty spaces between camera events represent periods of time during which the camera 
is not moving and is displaying its last position (Fig. 21-07).
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21.2.2  Manipulating and modifying camera events

Figure 21-07

• By default, a new event is created at the location of the cursor on the timeline. The length of the event corresponds to the time needed 
by the camera to move from the point of view of the previous camera event to the point of view of the event created (Fig. 21-07) 
depending on the navigation speed you are using at the time of creation (chapter 3.5).

• You can manipulate and modify events positioned on the timeline at any time. With your left mouse button, click the camera event 
to select it (Fig. 21-08), move your mouse from left to right while keeping the left button pressed to move the event on the timeline 
(Fig. 21-09). Press Delete to delete the selected event.

Figure 21-08 Figure 21-09

When you move or modify the length of an event, all subsequent events will be moved unless you press Shift at the same 
time (Fig. 21-10). The track of camera events is independent from the track of scene events. Only events on the affected 
track will move. 

Image 21-10

• If you press Shift when you move or modify an event between other events on the timeline, it will move between the two events without 
moving the events that follow it.
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Figure 21-12

• The transition time between two camera points is not fixed and you can vary it by dragging one or other end of the event. 

The longer the camera event, the slower the movement of the camera, and vice versa.

• If you reduce the length of your camera event to the minimum, this will become an instant camera event (Fig. 21-12). The movement 
of the camera between the previous camera event and this camera event will thus be instant. 

• When you attach one camera event next to another, you create a continuity of movement between the positions of the two cameras (Fig. 
21-11). This will be translated into a continuous movement, without stopping, between the camera events when reading and exporting 
the sequence.

Figure 21-11
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• When you create a camera event, the speed of its movement will depend on the real-time navigation speed you use at the time of 
creation. The longer the camera event, the slower the movement of the camera, and vice versa. To avoid variations in speed between 
your various camera events, you can normalise the speed of the entire sequence or of several selected camera events.

21.2.4 Camera speed

21.2.3 Adjusting the camera

The adjusted camera event will retain the same length on the timeline. It is, however, likely 
that the new camera position will be further away or closer than the old one. You can therefore 
“Normalize speed” of your camera event (chapter 21.2.4) to avoid having variations in speed 
on the path.

Figure 20-13

• If you are not satisfied with the point of view of your camera event, you can correct it using the camera events contextual menu. Select 
the camera event you wish to adjust and click your right mouse button to open the “contextual menu”. Choose “Adjust camera”. 
The camera event turns red while the position of your camera is being adjusted (Fig. 21-13). The adjustment is made using classic real-
time navigation functions. When you have finished adjusting the camera, re-open the camera events contextual menu and click “Adjust 
camera” again. The camera event turns back to green and the new camera position is taken into account.

Figure 20-14

• Select the camera event you wish to adjust and click your right mouse button to open the “contextual 
menu”. Choose “Normalize speed”. The “Normalize camera speed” window opens (Fig. 21-14). Next, 
choose whether you wish to modify the speed of movement of the entire sequence or just one or more 
events. Select the desired speed of movement and click OK. The camera events will adjust on the 
timeline.

A panoramic movement in a camera event does not constitute a movement of the camera, 
but merely a rotation of it. The time to perform the rotation will always be one second by 
default. Store Visualizer will always choose the shortest route to perform the rotation. If you 
wish to modify the speed of rotation of the camera, simply adjust the length of the event on 
the timeline.

The first camera event, representing the point of view of your camera during the creation of the sequence, can also be 
adjusted in the same way as the other camera events!
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21.3  Viewing the sequence in real time

• The “Move cursor to the start/ to the end of the sequence” icons position the cursor at the beginning or end of the current 
video sequence. 

• The “Move cursor to the previous/to the next event” icons allow the cursor to be moved between the camera events of the 
current sequence. 

• To view the video, make sure the cursor is positioned at the point at which you want playback to start and click the “Start or stop real-
time playback” icon. The timeline turns red (Fig. 21-15) to inform you that the cursor is now active. Click the icon again to stop playback 
of the sequence.

Throughout the creation of your video sequence you can view the actions of your camera and scene events using the timeline’s playback controls. 
The cursor (Fig. 21-15) represents the insertion point of events or playback on the timeline. You can place the cursor at any point in the sequence. The 
cursor may be active or inactive. If it is inactive, the cursor serves to determine the insertion point at the creation of a new event (see chapter 21.2). 
If it is active, the cursor represents a playback head on the timeline. By moving it, you can freely view the results of your sequence.

• Click the “Activate cursor” icon to activate it. The timeline turns red. Next, move the cursor to view the video according to the location of 
the cursor. Re-click the icon to deactivate the cursor. All interactive manipulations in the project (for example: navigation of the camera, 
creation or movement of objects, etc.) will automatically deactivate the cursor.

During playback of the sequence, you can reposition the cursor along the timeline by 
clicking the desired location. Playback will not be interrupted.

Fade effects between scene events (see chapter 21.4.1) will not be visible when viewing in real time. The result will only be visible 
on the exported video.

Figure 21-15
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21.4  Creating an event on the scene track

21.4.1  Creating a scene event

• You can add a scene event at any point on the timeline. Click and move the cursor (Fig. 21-05) to mark the insertion point of your next 
scene event.

• Next click the “Add an event to the scene track” icon situated in front of the scene events track and select “Add new scene event” 
(Fig. 21-16). 

The scene track of the timeline brings together the three types of events linked to the manipulation of objects: the scene event, the physics event 
et the product viewer event. The first scene event, created automatically during the creation of the sequence, includes the positioning information 
for all the 3D objects placed in your project.

A scene event is a complete automated copy of the scenegraph. The scenegraph 
includes all the information relating to the 3D objects placed in the project.

A scene event represents all the modifications relating to 3D objects that you have made in your project since the previous scene event. The 
modifications taken into account by a scene event are the creation of new objects, the creation of multiple objects, the deletion of objects, the 
replacement of objects and the manipulation of objects (movement, rotation and change of scale).

Figure 21-16

• By default, when you create a scene event, it will be instant (Fig. 21-17). The modifications made by the event to the 3D objects present 
in your project will be instant.

Figure 21-17

For example, if the scene event represents the creation of an object, the 3D object will 
be created instantly. If the event represents the movement of an object, for example 
the movement of a product from one shelf to another, the object will appear instantly 
on the other shelf. You will not see the object moving from one shelf to the other.
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• You can modify the duration of a selected scene event by dragging the end of the scene event (Fig. 21-18). The scene event will no 
longer be instant, but progressive over the entire duration of the event. This will have an impact on the modifications represented by the 
scene event, such as the creation of new objects, the manipulation of objects, etc.

For example, if you have moved a 3D object from one shelf to another, you will see the object moving 
from one shelf to the other. The speed of movement will depend on the duration of the event. The 
creation or deletion of a 3D object will take place via a fade during the scene event.

Figure 21-18
Attention: you cannot view fades in real time. They will be created when the video is 
exported.

• If you have made changes to the objects in your project and you wish that these are taken into account in an existing scene event, you 
can update the event. Select the scene event you wish to update and click your right mouse button to open the “contextual menu”. 
Choose “Update scene event”.

The first scene event created, representing all the 3D objects positioned in the scene 
during the creation of the sequence, can also be updated in the same way as manually 
created scene events!
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21.4.2  Creating a physics event on the entire scene

• You can add a physics event at any point on the timeline. Click and move the cursor (Fig. 21-05) to mark the insertion point of your next 
physics event.

• Next, click the “Add an event to the scene track” icon situated in front of the scene events track and select “Add new physics event” 
(Fig. 21-19). 

The physics event allows the physical simulation to be started during a defined period on the entire scene (by default) or on a selection of objects. 
See chapter 16 for further physics details.

Figure 21-19

The physical simulation linked to a physics event cannot be viewed by dragging the cursor 
along the timeline. You have to start real-time playback (chapter 21.3) to view the simulation.

Figure 21-21

• Drag the end of the physics event (Fig. 21-21) to modify its duration. The default duration of the physical simulation is 3 seconds. The 
physical simulation is stopped automatically at the end of the physics event.

After a physics event has been created (on the entire scene or on a partial selection), we 
recommend that you “Start real-time playback” (chapter 21.3) to view the result of the 
physical simulation. After playback, add a new instant scene event after the physics event 
(Fig. 21-20) to freeze the last position of the 3D objects affected by the physics. 
Failing this, there is a risk of random interactions when the next scene event is added.

Figure 21-20
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o If you have already created a physics event affecting the entire scene, this can be transformed into a partial physics event. 
Select the 3D objects to which you wish to apply the physical simulation. On the timeline, choose the physics event you wish to 
modify and click your right mouse button to open the “contextual menu” (Fig. 21-23). Choose “Assign partial simulation”. 
The physical simulation will then only be active on the previously selected objects.

21.4.3  Creating a physics event on part of the scene

• By default, the physics event will be active on the entire scene. If you are working on a project containing a large number of 3D objects, 
it may be preferable to simulate the physics on part of the scene.

o  Select the 3D objects to which you wish to apply the physical simulation. Next, click the “Add an event to the scene track” icon 
situated in front of the scene events track and select “Add new physics event”. A window will open (Fig. 21-22) to ask if you 
want to assign the physics to the selection or to the entire scene. Click Selection. The physical simulation of the event created 
will then only be activated on the objects selected during its creation.

Figure 21-22

Figure 21-23

If you choose Scene, the physics event will assign the simulation 
to the entire scene (see chapter 21.4.2).
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21.4.4  Creating a product viewer event

• You can add a product viewer event at any point on the timeline. Click and move the cursor (Fig 21-05) to mark the insertion point of 
your next viewer event.

• Next, click the “Add an event to the scene track” icon situated in front of the scene events track and select “Add new product viewer 
event” (Fig. 21-24). The product viewer event appears on the timeline (Fig. 21-25). The event is split into three parts. The duration of 
each part can be adjusted.

Attention: tracking cameras cannot be added if another camera event is already 
present above the viewer event. Remove or move the camera event to insert cameras 
to follow the product.

The product viewer event allows the “Product viewer” function (chapter 17) to be integrated into a video sequence. Like the real-time viewer, the 
event creates an animation in three parts of a product selected in advance. In the first part, the product will leave its original position and position 
itself at the point you have set. During the second part of the animation, the product will perform a configurable gyration. At the end of the event, it will 
return to its original position.

Figure 21-24

• Select the object you wish to animate.

Figure 21-25

• Store Visualizer allows you, if you wish, to automatically add cameras that will follow the product animated by a viewer event. Select 
the event and click your right mouse button to open “the contextual menu”. Choose “Add camera events to follow the product”. 
Two camera events will automatically be created on the camera track in parallel with the viewer event (Fig. 21-26). These cameras will 
automatically be calibrated to follow the animation created by the event.

Figure 21-26

• The settings of the animation, such as height, distance and gyration, can be modified in the event properties (chapter 21.5).
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21.5  Event properties
• Each event present on the timeline has properties and settings that can be modified at any time.

• Next, click the “Open event properties” icon situated next to the timecode. The “Event properties” window will open.

• Select the event the properties of which you wish to modify.

21.5.1  Properties of camera, scene and physics events

21.5.2  Properties of the viewer event

o  Event name: The name of the event.

o  Event length: Total duration of the event on the timeline, in seconds. 

o  Event name: The name of the event.

o  Event length: Total duration of the event on the timeline, in seconds.

o  Intro length: Duration of the first part of the event animation, when the object leaves its initial position.

o Extro length: Duration of the third part of the event animation, when the object returns to its initial position

o  Distance: Maximum distance reached in the direction of travel of the object during the animation.

o  Height: Maximum height achieved by the object during the animation.

o  Steepness: The incline of the displacement curve of the object during the animation.

o  Movement axis: Allows you to choose the axis along which the object moves during the animation (axis 
X, Y or automatic).

o  Gyration speed: Determines the speed of gyration in revolutions/second of the object during the second 
part of the animation.

o  Gyration angle: Determines the angle of gyration.

The physics event properties window will also specify whether the event in question affects part 
of the scene or the entire scene.
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21.6  Showing/hiding the path of the camera in the scene
The camera path defined by the events present on the camera track of the current sequence can be shown and manipulated graphically. The camera 
positions associated with the events are represented by blue squares (or red when a camera event is selected). These positions are connected by 
straight lines or curves. These represent the path taken by the camera during the playback or export of the video sequence. 

• Click the “Show/hide camera path in the scene” icon situated above the timeline. The path of the camera (blue line) as well as the 
position of the camera events (blue square) are displayed in the scene and can be modified. Click the icon again to deactivate the mode.

• The “Layout view” function (chapter 8.8) allows you to have a complete overview (Fig. 21-26) of your scene, of the position of your 
camera events and of the path taken by them. You can therefore easily identify camera tracks that risk crossing objects, shelves, etc.

Figure 21-27

o A straight line represents a camera event that ends with a 
delay before triggering the next camera event.

o A curve represents a succession of connected camera 
events.

o A gap between two points indicates that the next camera 
event is instant.

• You can freely move the positions of the cameras. Click the blue square symbolising a camera event (Fig. 21-27) and move it to the 
desired location. The movement will be in the horizontal plane. Press Ctrl during the movement to modify the height of the camera. The 
path taken by the camera will alter according to your changes. This may affect the speed of movement. It is recommended that you 
check the result of your modifications using the real-time playback of the sequence. 

The shape of the lines indicates the type of camera event:
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21.7  Exporting the video

• Click the “Export movie” icon situated above the timeline.

• Enter the name of the video file you wish to export. By default, the video will be encoded in H264.

• The “Movie export settings” window will appear (Fig. 21-28). Select the video encoding settings in the list of predefined options 
(chapter 21.7.1) and then click Proceed to export the video.

Figure 21-28

Figure 21-30
Figure 21-29

• When the video is exported, you can view your video immediately by clicking Play (Fig. 21-29). Store Visualizer will automatically open 
the video with your default multimedia player.

By default, when you export a video, you export the entire timeline with all the events on the active tracks. If you only want to export part of the timeline, 
set an input point (IN) and an output point (OUT) on the timeline. This will only export active tracks between these two points! 

• Click on the IN and OUT sliders and hold the mouse down to move them to the desired 
position.

21.7.1  Exporting the video
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21.7.2  Predefined video encoding settings

Setting the video encoding is not always easy. We suggest that you choose from several predefined settings (Fig. 21-30) that refer to the use of the 
video:

o Quick preview: You wish to view the result of your video quickly, without being too concerned about the quality and size of the 
image.

o For the web (SD): You wish to broadcast your video on the web but do not want too high an image resolution (360p).

o For the web (HD): For broadcasting your video on the web in HD quality (720p).

o High quality presentation: Ideal for presentations. The video will have an HD image resolution (720p) and will use a higher 
antialiasing filter. 

o For broadcast or editing: Video of maximum quality and full HD resolution (1080p) for editing or for broadcasting on full HD media 
(1080p).

o Custom: For advanced uses, you can personalize the encoding settings. See chapter 21.7.2.
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The final quality of your video will depend on the video encoding settings. Attention: the higher the quality, the longer the export time 
and the greater the size of the video file. All this also depends on the total length of the video.

21.7.3  Video encoder and video settings

o Format: Lets you select a video encoder. The encoder selected by default is H264. The available 
formats depend on your operating system and the codecs you have installed. 

o Profile: Lets you choose the H264 profile used for encoding. This setting is only available on Windows.

o Quality: Determines the encoding quality of the video. A video of minimum quality will be more 
compressed (its file will be smaller) but will have significant graphic artefacts (image pixelation).

o Framerate: Represents the number of images displayed in one second.

o Image size: Proposes the standard image sizes. You can personalize the size if required.

o Antialiasing: An additional antialiasing filter can be applied to increase the quality of your video.

o Resolution: This is the size of the image in pixels.

If the encoding settings presented above do not suit the desired use, Store Visualizer lets you personalize all the video encoding settings.

Figure 21-31

o Color space: The color space used to encode the video. In automatic mode, BT 601 is used for SD 
video and BT 709 for HD video. If you encounter problems connected with the color management of the 
video on a non-standard player, you can manually select the appropriate color space.

o Adjust for QuickTime gamma: Tick the box if the exported video is intended to be displayed in 
QuickTime player.
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Due to the quality of its real-time 3D graphic rendering, Store Visualizer simply had to be compatible with the new generation of VR headsets. Wearing 
a VR headset, users will have the sensation of being immersed in the 3D virtual world. 

Use of a VR headset is not compatible with spherical photographic environment.

Store Visualizer supports the Oculus Rift and the HTC Vive, as well as their respective controllers. 

Chapter 22 : VR headset compatibility

22.1  Introduction
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Store Visualizer is compatible with a certain number of touchscreens. The software recognizes when a compatible touchscreen is connected to 
the computer and automatically switches to a special navigation and interactive mode. This mode offers users a simplified interface, enabling easy 
navigation and interaction within the 3D environment (Fig. 23-01).

Contact Esko support for further information about supported screens. Touchscreen navigation mode is not compatible with the Mac 
platform!

Figure 23-01

Chapter 23 : Using a touchscreen
23.1  Introduction
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• It is preferable to use both hands when navigating within the 3D scene using a touchscreen. 

o  Move around:

o  Rotate view:

 Slide the index finger of the LEFT hand along the top of the Walk arrow to MOVE FORWARD
 Slide the index finger of the LEFT hand along the bottom of the Walk arrow to GO BACKWARDS

 Place the index finger of the RIGHT hand on the 3D scene and slide it across the screen in the direction you wish 
to look. 

Slide the left index finger slightly towards the top or bottom of the Walk arrow to increase the speed of movement. 
A new arrow will appear to warn you that you are moving more quickly.

23.2  Move through the 3D environment using the touchscreen
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o 	 Move forwards: touch the screen with your index finger and thumb and move them apart.

o 	 Move backwards: touch the screen with your index finger and thumb and bring them together.

• To navigate within the 3D scene using gestures.
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• Touch the “Go to location” icon in the toolbar. A list showing the different stored camera views will appear.

• Touch one of the cameras in the list. The 3D view will switch to the selected location.

• Touch the “Reset” button located in the toolbar to reset the project while activating the scene event.

• Ensure that the option “Reset activates the first scene event” is selected in the Touch controller settings (see chapter 23.6).

The “Reset project” function is used when you wish, after multiple manipulations of objects, to reset the project to its initial state when loaded.

The project will reinitialize activating the initial scene event created in the video editor, in the sequence selected. If you have not defined 
any scene event, the reset function will be unavailable.

This function is frequently used during demonstrations at trade shows, for example, where visitors are given free access to their 
simulation. In this way, you can easily reset the project to its initial state without having to reload it.

23.3  Camera list

23.4  Reset project
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The touchscreen offers the functions generally used to interact with objects, such as select, move, rotate, add or remove.

• Touch the “Interact” icon located in the toolbar (Fig. 23-01) to enter interactive mode. A toolbar specific to interactive mode appears.

• Ensure that you are in interactive mode by touching the “Interact” icon.

• Touch an object to select it.

• The “Object selection” function in product mode is automatically activated.

• Touch the desired construction mode to activate it.

• Touch the “Product mode” icon located in the interactive toolbar (Fig. 23-02). A list containing the three construction modes will appear. 
“Product mode” is activated by default.

Figure 23-02

o 	 Products: standard manipulation mode used for placing and interacting with the products in the store.

o 	 Shelves: mode used to quickly modify the configuration of panels (individual shelves) within a shelf 
frame.

o 	 Store design: enables quick creation and manipulation of shelf frames, creation of shelving units and 
creation of complex layouts in the store.

23.5  Interacting with the 3D environment

23.5.1  Selecting an object

23.5.2  Changing construction mode



174										                                  	            Store Visualizer 18

By default, objects are moved along the X and Y axes.

• Once you have selected an object, slide your finger to move it.

• Once you have selected an object, slide two fingers together side by side to move the object from top to bottom.

When you remove the second finger, movement continues along the X and Y axis only.

• Once you have selected an object with your index finger, leave the index finger on the screen and simultaneously use your thumb to 
rotate the object. Moving your thumb from left to right will cause the object to rotate to the left and vice versa.

When you remove your thumb, rotation stops.

• Once you have selected an object in the scene by touching it, its 3D model is automatically selected in the library thereby 
enabling you to add it again.

• Touch a horizontal surface to add new products. These will be added in the location that you have touched.

• Touch the “Add product” icon located in the interactive toolbar.

• Touch the “Go back” icon to stop adding products. 

23.5.3  Move a selection of objects

23.5.4  Move a selection of objects from top to bottom

23.5.5  Rotate a selection of objects

23.5.6  Adding a product
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The “Pick up product” function is similar to the product display mode which allows you to automatically pick up a product from its shelf so that you 
can freely inspect it in detail.

• Touch the “Pick up product” icon in the interactive toolbar or touch the object twice to automatically pick it up. The selected object 
will move from its original position and be placed in the center of the screen.

• Touch the object that you want to inspect to select it. 

• Slide your finger across the screen to rotate the object. 

• Touch the “Go back” icon or touch the object twice to automatically return it to its original position. 

If you move your finger far enough away from the object it will automatically return to its original position.

2X

• Touch an object that you want to remove. The “Remove” icon appears. 

• Touch the “Remove” icon located in the interactive toolbar to remove the selected object.

2X

23.5.7  Removing

23.5.8  Picking up a product
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The “Touch controller settings” window opens on the “Preferences” page (see chapter 24). Select Preferences > Interactivity > Navigation devices 
> Touch control. Click the “Configure the selected device” icon to open the “Touch controller settings” window (Fig. 23-03).

Image 23-03

• Show help after (seconds): display tooltips on using touch functions after the desired number of 
seconds.

• Start movie after (seconds): automatically starts the video sequence selected in your Video editor 
after the desired number of seconds. If you do not have any video sequences or video this will not have 
any effect.

• Show store mode selector tap button: displays the store mode selector tap button (see chapter 
23.5.2) in the touch control interface. If this option is not selected only the “Product mode” will be 
activated. You will therefore not be able to manipulate the shelving units or shelf frames via the touch 
control interface.

• Pick up products from shelves only: when this box is selected, only products located on shelves 
can be viewed with the “Pick up product” function. If the box is not selected, you will be able to view 
products placed on shelves other than shelf frames, as well as products placed on the ground. 

• Reset activates the first scene event: activates the “Reset project” function in order to reset the 
project using a scene event (see chapter 23.4).

23.6  Touch controller settings
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Chapter 24 : Preferences
To access the Preference pages, right click anywhere on the gray empty area (the 3D render area). The main contextual menu will appear. Select 
File > Preferences. The “Preferences” dialog window will appear.

24.1  System settings

o 	 Use native dialogs: Use the native windowing system of the host operating system 
for Store Visualizer dialogs.

• GUI settings (User interface settings)

o 	 Sidebar open by default: Open the sidebar when starting Store Visualizer.

o 	 Enable tool tips: Enable the display of help tooltips when hovering over UI items.

o 	 Theme: The user interface color theme (Light or dark colors).

• Language
o 	 Selects the user interface language.

• Welcome screen
o 	 Shows the welcome screen everytime Store Visualizer starts.

• User interface size
o 	 Normal: Use the normal option on displays with a standard DPI, such as full HD 

displays.

o 	 Large and very large: use these options on high DPI displays, such as 4K displays.
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• Display properties

o 	 Enable LOD system: Enable or disable the Level Of Detail rendering acceleration 
system. For more information about the LOD system, see chapter 6.9.

o 	 Fullscreen: Store Visualizer will start in fullscreen mode, removing all Windows UI 
elements.

o 	 Windowed: Store Visualizer will start in a window.

o 	 Antialiasing filter: The type and strength of the antialising filter used, to reduce 
jagged edges in the visualization. Antiliasing will significantly improve the quality of 
the rendering, but it will impact performance and increase memory usage.

• Fullscreen

o 	 Allow video mode switching: Allow Store Visualizer to switch to a different video 
mode and resolution than the one Windows is using.

o 	 Surface compression: Allow the use of compressed internal render surfaces, in 
order to reduce memory consumption.

o 	 Video mode list: List of available video modes and resolutions.

o 	 Colors: Video mode color depth (default: automatic).

o 	Refresh rate: Video mode refresh rate (default: automatic).
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o 	 Invert vertical mouse: Invert the vertical movement axis of the mouse for navigation.
• Navigation settings

o 	 Sensitivity: Changes the sensitivity of the mouse tracking movements. Move the 
cursor to the left to reduce the sensitivity of the mouse and to the right to increase the 
sensitivity.

o 	 Limit vertical angle: Limit the vertical viewing angle to the bottom - top range, 
avoiding over-turning of the navigation camera.

o 	Wire color: The color of the selection gizmo.

o 	Wire width: The width of the selection gizmo.

• Object selection

o 	 Default distance unit: The default distance unit used by Store Visualizer.
o 	 Default weight unit: The default weight unit used by Store Visualizer.

• Project settings

• Default report form
o 	 The report form used by default (only available when multiple report form plugins are 

loaded).

o 	 Default author: The default author assigned when creating new projects.

• Navigation devices: List of all navigation devices connected to your computer that are 
recognized by Store Visualizer. Select the device from the list and click the “Configure 
selected device” icon to adjust its parameters.
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24.2  Paths and directories

o Texture search paths: Search paths for texture files.
o Scene search paths: Search paths for 3dw scene files.

• Search paths: Search paths define the locations where Store Visualizer will search for 
resources when loading a project.

o Library search paths: Search paths for l3dw library files.

o HDR sphere search paths: Search paths for vtcep spherical environment files.

24.3  Graphics system information

• Graphics system information: This page displays information about your graphics card 
and the OpenGL driver.
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24.4  Textures

Additional 3D: These pages contain highly specific settings controlling the visual. This data was automatically adjusted to your system 
when Store Visualizer was installed. Modifying these settings can very seriously degrade performance and lead to application failures or 
instability. Please do not modify these settings unless specifically instructed to do so by technical support.

o 	 Compress control maps: Allow the lossy compression of channel control maps, 
such as reflectivity, glossiness or opacity textures.

• General settings: The following settings trade memory usage and performance for quality:

o 	 Compress normal maps: Allow the lossy compression of normal maps.

o 	 Convert 16 bit maps to 8 bit: Convert 16 bit textures to 8 bit textures while loading 
(reduces memory usage).

• Filter: The filter type used for textures (default: best available). A high setting (anisotropic 
or better) is very important for good quality.

• Anisotropy: If using an anisotropic filter, this entry selects the quality of the anisotropy 
(higher quality settings can slightly reduce performance).

• Regular textures: Limit resolution and compression level of standard textures.

• High detail textures: Limit resolution and compression level of important and high priority 
textures (including those from high priority libraries).

• Static textures: Limit resolution and compression level of the textures from the static 
environment.

o 	 Load textures on demand: Allows Store Visualizer to load model textures when used. 
This settings will reduce memory consumption on large projects but may introduce 
small delays when clicking on a model in a library.
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For a full explanation on the operation and use of stereoscopic rendering mode for Store Visualizer, please consult the document created by Esko by 
clicking the following link: SSV - Stereoscopic rendering information.

24.5  Stereoscopic rendering

https://wiki.esko.com/display/KBA/KB78626798%3A+Studio+Store+Visualizer+-+Stereoscopic+rendering+information
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Navigation 23
28

Add a new camera 33

Enable free look mode 28 Switch to previous camera 33

Orbit around target 29 Switch to next camera 33

Select orbit target point 29 Toggle movie timeline visibility 151

Height 30 Toggle layout view 30

Speed 32 More actions > Film and lens settings 36

More actions > Edit camera settings 34 More actions > Align camera to nearest axis 31

Chapter 25 : Icons and functions
25.1  Navigation panel
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Object control 39 Snap and alignment settings 71

Change manipulation mode 59 Change transform coordinate system 63

Select objects 59 Anchor: change transform pivot point 63

Create a new object 57 Replace model of all selected objects 64

Create an object array 65 Product viewer 141

Move selection 60 More actions > Delete 64

Rotate selection 60 More actions > Array settings 65

Scale selection 61 More actions > Panel positions 79

Auto select 62 More actions > Snap frames to frames 71

Affect X axis 60 More actions > Store layout view 78

Affect Y axis 60 More actions > Product viewer settings 142

Affect Z axis 60

25.2  Object panel
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25.3  Environment panel

Environment 114 Stereo and multi-display control 115

Environment type settings - Refresh reflections 116

Tonemapping settings 114 Edit reflection spheres and zones 116

Adjust static elements 119 Open reflection zone settings 116

25.4  Physics panel

Physics 131 Put scene to sleep 132

Start simulation 131 Toggle between physics or conventional move 133

Stop simulation 131 Drag object by its pickup point 134

Simulate all currently selected objects 132 Show model with collision envelopes 136

Simulate the entire scene 131 Show collision envelopes 136
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25.5  Interface

Help 13 Graphic system information 180

Show information about the project 37 HDR mode is enabled -

Save project modifications 18 Graphics memory usage (%) -

25.6  Sidebar

System Open the “System” tab.

Tools Open the “Tools” tab.

Scene Open the “Scene” tab.
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25.7  File

Open project from list

Show preset information

Remove project from list

Clear entire project list

• In the system sidebar, select: System > File.
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25.8  Command history

Undo entry

Redo entry

Goto history entry

Redo all inactive entries

Collapse all entries below current

Remove all entries above current

• In the system sidebar, select: System > Command history.
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25.9  Libraries

Models 40 Create a new model or resource 110
112

Assemblies 80 Copy 40

Search entry 84 Cut 40

Library 40 Paste 40

Important library 53 Delete from library 40

Import model or resource 41 Create new folder 49

Import image 47

• In the system sidebar, select: Tools > Libraries.
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Rotate model 54 Show collision envelopes 136

Pan model 54 Edit shelf metrics 77

Zoom model 54 Model complexicity 49

Center model 54 Model contains reflection 54

Model side views 54 Select by current model 54

Model view options 54 Refresh the model and textures 54

View or assign model sides 55 Show or edit anchor points and lines 68/69

Show model dimensions 54 Edit raytracing surfaces 105

Show model with the range of the lighting 129 Level of detail settings 56

Show model with collision envelopes 136 Select reflection environment 54

25.10  Model browser

• In the system sidebar, select: Tools > Model browser.
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25.11  Scenegraph

• In the system sidebar, select: Scene > Scenegraph.

Search entries 84 Freeze or unfreeze objects 86

Filter entries 85 Group object 87

Refresh filter 85 Open group 88

Select none 85 Object array 84

Select all 85 Group objects 87

Selected object 84 Dissociate current group 87

Show / hide object 86 Explode current group 87
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25.12  Material editor

Pick material from a model 90 View (color/ reflectivity/ glossiness/ embossing/ 
opacity) image

107

Material actions 90 Modify (color/ reflectivity/ glossiness/ embossing/ 
opacity) map

107

Open material presets 90
109

Modify (color/ reflectivity/ glossiness/ embossing/ 
opacity) map

107

Create a new preset from current material 109 Activate selected preset 109

Remove selected preset 109 Default materials 109

Create a new folder 109 User materials 109

25.13  Material presets

• In the system sidebar, select: Scene > Material editor.

• In the system sidebar, select: Scene > Material editor > Open preset windows > Material presets.
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25.14  Creating and editing a video
• In the Navigation toolbar, click the Toggle movie timeline visibility icon.

Toggle movie timeline visibility 151 Move cursor to the start / to the end of the sequence 157

Creating a new sequence 151 Move cursor to the previous / to the next event 157

Deleting an existing sequence 152 Add new camera event 153

Activate or deactivate a track 152 Add an event to the scene track 158

Activate cursor 157 Open event properties 163

Start or stop realtime playback 157 Showing / Hiding the path of the camera in the 
scene

164

25.15  Model meta data

Add new fields 122 Remove selected fields 122

Import meta data 122 Show product meta data 122
127

• In the system sidebar, select: Scene > Model meta data.
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Chapter 26 : Shortcuts

F1 Help

F2 Product manipulation mode

F3 Shelf creation mode

F4 Store design mode

Space Enable free look mode

s Select objects

c Create a new object

f Create an object array

m Move selection

r Rotate selection

a Scale selection

e Replace model of all selected objects

p Product viewer
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v Orbit around target

x Affect X axis

y Affect Y axis

z Affect Z axis

t Layout view

k Pick a material from a model

o Model to library

L Auto select

Delete
or 

Ctrl+d

Remove all selected objects

Shift+f Array settings

Shift+p Product viewer settings

b Toggle sidebar visibility

i Toggle fullscreen mode

Shift +m Duplicate object + move

Shift +r Duplicate object + rotate
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Ctrl+i Import model or resource

Ctrl+o Open file

Ctrl+s Save

Ctrl+p Print

Ctrl+z Undo

Ctrl+y Redo

Ctrl+x Cut

Ctrl+c Copy

Ctrl+v Paste

Ctrl+f Freeze current selection

Ctrl+g Group current selection
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Shift 
+ m

Toggle between physics or conventional move
(Physics module)

Shift 
+ w

Toggle weak collisions
(Physics module)

d Drag object by its pickup point
(Physics module)

Shift+s Stereoscopic On/OFF

Alt+F4 Quit

Ctrl+Left Switch to previous camera

Ctrl+Right Switch to next camera
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